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1. Situation. To provide policy for the use of iPad devices 
within 2d MAW. In order to improve safety and prepare for 
deployments into theaters where they are currently utilized, 2d 
MAW is procuring iPads (up to 50) for both rotary wing and fixed 
wing squadrons in CONUS. The iPads will serve as electronic map 
boards to replace the multitude of maps that the pilots must 
reference which provide a single source point of information. 

2. Mission. 2d MAW will employ the iPad device Initial 
Operational Test (lOT) support pre-deployment training while in 
keeping with Marine Corps policy regarding information security. 

3. Execution. IPads are not accredited for use on any 
government network and have not undergone any type of 
Information Assurance (IA) testing. Their use will be limited 
by the restrictions listed below. Ultimately, commanders who 
own/use the devices assume responsibility for the proper 
employment, storage and security management as outlined in this 
policy. 

DISTRIBUTION STATEMENT A: Approved for public release; 
distribution is unlimited. 
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a. IPads will be procured through the government 

Instructional Technology (IT) purchase process, per reference 
(a). Per reference (b) paragraph 3.F, personal iPads will not 
be used in an official capacity. Government iPads will be 
indentified by affixing a Government Property Sticker to the 
back of the device. 

b. IPads will not be directly connected to any network via 
wireless or physical connection per reference (c). Particular 
caution must be exercised to ensure iPad devices will not 
connect to a Department of Defense (000) controlled network to 
include (but not limited to) Secret Internet Protocol Router 
Network (SIPRNET), Non-classified Internet Protocol Router 
Network (NIPRNET) and Combined Enterprise Regional Information 
Exchange System-International Security Assistance Force 
(CENTRIXS-ISAF) networks. Authorized data, as defined later in 
this document, must be transferred to the iPads via Universal 
Signal Bus (USB) tether from a dedicated workstation with 
limited network access of a non-DoD origin (see enclosure (1)) 

c. Dedicated workstations used to support the iPads will be 
brought to the unit S-6 for virus and client software updates at 
a minimum of every (45) days. The 2d MAW Cyber Security Office 
will inspect the device once every (90) days. 

d. IPads will not process classified information. Data 
processed on the iPads will not be marked or manipulated in any 
way that renders that data classified per reference (c). Any 
processing of classified information on an iPad will be 
considered a security violation. 

e. After initial activation, setup and application 
installation, restrictions and settings will be applied per 
enclosure (2). Once setup, the government owned iPad devices 
will not be modified (hardware or software) except by 2d MAW G-6 
IA personnel. If a using unit discovers an application that 
would extend operational functionality, the name of the 
application with the iPad services utilized by this application 
will be submitted to 2d MAW Cyber Security Office for routing to 
Headquarters Marine Corps (HQMC), C4 IA Division. 

f. The use of the Apple Application Store is strictly 
limited to the initial activation of the device, download of map 
and e-reader centric applications as outlined in reference (c), 
and for updating of the Apple iOS, iPad Client and iPad 
applications as appropriate. These functions will be conducted 
from the unit designated stand-alone PC, utilizing a commercial, 
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non-DoD internet connection. This internet connection is to be 
utilized ONLY for this purpose. 

g. Wireless, 3G, and Bluetooth services internal to the 
iPad will remain in the "off" position at all times and will not 
be utilized per reference (c). 

h. Government owned iPads will not be connected and/or 
synchronized to personal computers. This poses a possible risk 
of information leakage from the devices to the World Wide Web. 
Additionally, these devices will not be used to store or play 
personal media such as music and movies. 

i. Due to inherent non-mitigable security vulnerabilities
 
(similar to cell phones and other Personal Electronic Devices
 
(PEDs) ), iPad devices will not be taken into a classified
 
environment. Exceptions are authorized flight simulation 
training and planning centers. 

j. Any CD/DVDs and hard drives used in the transfer of 
information between the stand-alone iPad station and network 
devices must be checked for malware by running an antivirus scan 
using current definitions. Antivirus software and definitions 
may be acquired from the local S-6 office. 

k. Authorized data allowed on the Government iPad devices 
is as follows: 

(1) Navigational maps. 

(2) Navigational map overlays. 

(3) Aircraft specific technical manuals. 

(4) Aircraft specific publications. 

(5) Flying and/or navigational aids and charts. 

1. There is no government contracted maintenance support in 
place for the iPad at this time. If software or operating 
system support is required, it will be provided by the 
manufacturer according to the manufacturer's warranty support. 
In conjunction with the 2d MAW AC/S G-6, iPad end users will 
coordinate directly with the manufacturer in order to execute 
warranty support. 
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m. If an iPad is damaged beyond the scope of warranty 

authorized repair, 2d MAW A/W G-6 will contact HQMC C4 IA 
Division with a notification of a damaged device. The using 
unit will coordinate with the 2d MAW A/C G-6 to request a new 
device through the Information Technology Procurement Request 
Review/Approval System (ITPRAS) using unit funds. Because 2d 
MAW is only authorized to procure "up to 50 iPads" (reference 
(c)), 2d MAW will not be allowed to procure a replacement until 
authorized by HQMC C4 IA. 

n. All iPad users will read and sign the 2d MAW iPad user 
agreement form (enclosure (3)) which will be held by the unit. 

o. All units receiving iPads will be required to develop a 
local SOP for utilization of the devices within the unit. 
Enclosure (4) is provided as an example. 

p. In the event of deployment, units are subject to 
guidelines established in reference (d). 

q. Unit security managers will conduct a spot audit of the 
information contained within the iPad prior to and immediately 
following flight or simulator training. This is to ensure that 
the aggregate of the data contained within the device does not 
raise the classification level of the data to a level greater 
than "Sensitive but Unclassified". 

4. Administration and Logistics. The iPad devices are 
specifically issued as an aviation navigational aid to be used 
to augment existing capabilities organic to aircraft. As such, 
iPads will be treated and accounted for as aviation specific 
equipment. The equipment will be delivered to the local Marine 
Aviation Logistics Squadron (MALS) Aviation Supply Department 
(ASD) Squadron Support Division (SSD) Customer Records Branch 
(CRB) as Table of Basic Allowance (TBA) assets. The iPads will 
then	 be assigned as sub-custody assets to a Responsible Officer 
(RO) at the MAGs receiving the iPads. The MAG RO will then 
issue the iPad devices to the local squadrons. Per reference 
(e) the local MALS will submit a request to HQMC to update the 
local TBA via the 2d MAW Aviations Logistics Division (ALD). 
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5. Command and Signal 

a. Command. This Order is applicable to all personnel 
within 2d MAW. 

b. Signal. This Order is effective the date signed. 

~GAN 
Chief of Staff 

DISTRIBUTION: A 
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2D MARINE AIRCRAFT WING IPAD SECURITY SETTINGS 

1. Restrictions 

a. Safari - Off 

b. Youtube - Off 

c. iTunes - Off 

d. Ping - off 

e. Install Apps - Off 

f. Deleting Apps - Off 

g. Location Services - Off/Don't Allow Changes 

h. Accounts - Don't Allow Changes 

i. In-App purchases - Off 

j. Movies - Not Allowed 

k. TV Shows - Not allowed 

1. Multiplayer Garnes - Off 

m. Adding Friends - Off 

2. Passcode Lock 

a. Simple Passcode - Off 

b. Turn Passcode - On 

i. The local organization will need to develop an 8-16 character 
password, utilizing a minimum of 1 upper case letter, 1 lower case letter, 1 
number and 1 special character. 

ii. The simple passcode will need to be turned off before you can 
enable the "Turn Passcode on u setting. 

c. Require passcode - immediately 

d. Erase Data - On 

3. Auto-Lock 

a. When not in use within the aircraft, the Auto-Lock should be set for 
five minutes 

b. When in use in the aircraft, Auto-Lock should be set to "Never u
• 

Enclosure (2) 



SQUADRON LETIERHEAD 

2ND MARINE AIRCRAFT WING, IPAD USAGE AGREEMENT 

Your signature below verifies that you have read and understand the iPad usage policy and the guidelines, procedures and 
responsibilities outlined below and agree to comply with them. 

Guidelines: 

I) AlI users issued a Squadron iPad must sign a iPad user agreement form. 

2) Use of Squadron iPads is for official use only. 

3) Squadron iPads will be connected only to the squadron stand-alone computer. 

4) Squadron iPads will NOT be synchronized with personal computers. 

5) Use ofwircless, 3G and Bluetooth services is prohibited 

6) Only iPads and services outlined in the Squadron iPad contract(s) will be permitted. 

7) No downloading of songs, applications, videos or any other items to Squadron iPad. 

8) iPad users shall not "loan" or otherwise make available their iPad to non-Marine Corps personnel. 

9) iPad users are responsible for services received on their respective devices. 

User Responsibilities: 

I) Improper use of the iPad can be considered misappropriation of Government funds which may result in disciplinary action. 

2) An iPad user must surrender the iPad to the local unit Supply upon termination of duties with the unit (Le. retirement or 
PCS/A). At this point, no further use of the iPad is authorized. Transferring the iPad to the incoming replacement is not 

authorized unless it is conducted at the local Unit Supply Office. 

iPad Assigned serial number: _ 

iPad User: Date: _ 

PRINT SIGN 

Supply Chief: Date: _ 

PRINT SIGN 

Date returned to Supply: Supply Clerk Name: _ 

PRINT SIGN 

Enclosure (3) 
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UNITED STATES MARINE CORPS 
MARINE AIRCRAFT GROUP	 14, 2D MARINE AIRCAFT WING 

U.S. MARINE CORPS FORCES ATLANTIC 
CHERRY POINT, NORTH CAROLINA 28533-0051 

S-6 
02 Jun 11 

From: Commanding Officer, Marine Aircraft Group 14 
To: Distribution List 

Subj: STANDARD OPERATING PROCEDURES (SOP) FOR MAG-14 IPAD USE 

Ref: (a) iPad Interim Flight Clearance 
(b) iPad User Agreement 
(c) Bit Map User Agreement 
(d) Bit Map Files Acquisition Guide 
(e) Combat iPad Administration Manual 

1. Purpose. The purpose of this SOP is to provide the Squadron Co~manding 

Officer and Squadron iPad Representatives with a detailed overview of the use 
of iPad assets within MAG-14. Further, this SOP will serve as a reference for 
all questions and issues related to iPad usage. 

2. General. It is clear that the aviation community can benefit from the ever 
changing advancements in technology from the civilian sector. Among these 
advancements is the multimedia, touch-screen device called the iPad. The use 
of this equipment has been proven to substantially increase situational 
awareness and effectiveness of today's war fighter. Therefore, widespread 
distribution and established SOP's are a requirement and responsibility of 
MAGs throughout HQMC. 

3. Recommendations. Recommendations concerning the content of this SOP are 
invited. Recommendations shall be forwarded to the MAG-14 S-3. 

E. A. Mamajak 

DISTRIBUTION:	 MAG-14 S-3 
MAG-14 S-6 
MAG-14 DSS 
VMAT-203 
VMA-223 
VMA-231 
VMA-542 
VMAQ-l 
VMAQ-2 
VMAQ-3 
VMAQ-4 
VMGR-252 



------------------------------------------

Change to Reference Submittal Form 

LName FName MI Rank Unit Date 

Type of Recommendation (circle applicable) 

Addition Deletion Change 

Explanation (provide additional documentation if necessary) 

For Office Use Only 

Date Received Doc Number 

Applicable Y N 

Date Modification Made 

Modifier 
LName FName MI Rank 

Notes: 



Change to Reference Tracker 

Doc Num Mod Description Date 



Contents 

Section Description 

I. Getting Started 

1. iPad Equipment 

2. Rules and Restrictions 

II. 

3. Setting up 

iTunes 

the iPad Computer 

III. 

IV. 

V. 

1. iTunes Settings 

2. Downloading iPad Apps 

3. Initializing a New iPad 

4. Restoring / Updating an iPad 

5. Creating a Backup and Version Control 

Bit Map 

1. Producing Maps for Bit Map 

2. Uploading Maps to Bit Map 

3. Waypoints in Bit Map 

OziExplorer 

1. Using OziExplorer to Georectify an Image 

2. Using OziExplorer to Add Grid Line Labels 

3. Background - Waypoint Files 

4. Adding Labels to a GRG in OziExplorer 

5. Convert the Bitmap Images to JPEGs 

GoodReader 

to a GRG 

1. Uploading Files to GoodReader 

2. Using GRGs in GoodReader 

VI. Appendix 

A. iPad Interim Flight Clearance 

B. iPad User Agreement 

C. Bit Map User Agreement 

D. Bit Map Files Acquisition Guide 

E. Combat iPad Administration Manual 

VII. List of Abbreviations 



Chapter I
 
General
 

I. General 

1. iPad Equipment 

It is recommended that before squadrons use the iPad, they purchase 
some kind of protective covers, preferably a hard cover, either an iPad 
kneeboard or clip, and multiple other items. At a minimum, to use the iPad 
inside the aircraft, individual iPads must be equipped with some sort of 
protective case and the pilot must utilize either an iPad kneeboard or the 
'MyClip' accessory. Below is a list of other recommended items for use with 
the iPad and standalone computer. 

Equipment Name Justification 

MyClips Kneeboard clip used in the aircraft. 

Soft (silicone) Cases Protects the iPad during use in the jet. Will work with the MyClip Accessory. 

Hard (Otter) Cases Protects the iPad during storage and transport. 

Glare Reducing Screen Protectors Reduces glare and protects/extends screen life. 

Adobe Acrobat Professional
 
Software For the iTunes standalone computer. Used for converting .PDF files to .JPG files.
 

Used to geo-rectify maps to provide a moving map capability. Also used to add grid lines and 
waypoints to GRGs. 

OziExplorer Software Must be downloaded to standalone computer. 

Stylus Pens Used to write while in aircraft without taking gloves off. Can attach to the iPad via headphone jack 

2. Rules and Restrictions 

IPads are not accredited for use on any government network, and have 
not undergone any type of information assurance testing. Therefore, their use 
will be limited by the following restrictions: 

a. iPads will not be connected to any government network, to include 
SIPRNET, NIPRNET, and CENTRIXS-ISAF networks. Any data loaded to the iPads 
will be transferred from a stand-alone computer. 

b. Stand-alone computers will be taken to the 2d MAW G-6 Computer 
Information Assurance section for virus and operation system updates at a 
minimum of every (45) days. 

c. The wireless, 3G and Bluetooth devices internal to the iPad will 
remain in the "off U position at all times. These services will be disabled 
and password protected by the local S-6 representatives. 



d. iPads will not process classified information. Data processed on 
the iPads will not be marked or manipulated in any way that renders that data 
classified. The processing of classified information on an iPad will be 
considered a security violation. 

e. iPads will not be supported by the 2D MAW G-6. If software or 
operating system support is required, it will be provided by the 
manufacturer. As commercial, off-the-shelf equipment, all maintenance for the 
iPads will be handled directly with the manufacturer. 

f. iPads have to be bought through a government Information 
Technology purchase process. No personal iPads will be used in an official 
capacity. 

g. CD/DVDs and hard drives used in the transfer of information 
between the standalone station and network devices must be checked for 
malware by running an antivirus scan using current definitions. Antivirus 
software and definitions may be acquired from 2d MAW G-6 Network Defense 
section. 

h. The use of the Apple Application Store is strictly prohibited. 
The applications available via this Application Repository have not been 
certified via IA procedures and may possibly contain viruses and or malware. 

i. Government owned iPads will NOT be connected and or synced to 
personal computers. This poses a possible risk of information leakage from 
the devices to the world wide web. Additionally, these devices will not be 
used to store and or play personal media such as music and or movies. 

3. Setting up the iTunes Computer 

The iPad uses the iTunes application to initialize and load apps and 
data (refered to as "syncing" the iPad). Multiple iPads can be synced with a 
single computer running iTunes, but iPads cannot easily be synced with more 
than one iTunes computer (attempting to sync an iPad to a second computer 
will erase all the existing data on the iPad). This means that your iPads 
will be tethered to a single computer running iTunes, which is effectively 
your base station. However, multiple detachment sites should have their own 
iTunes computer. 

At a minimum, this computer must have a recent version of iTunes 
installed. To be fully effective (capable of adding multiple georectified 
maps and GRGs to the iPad), you also need to install an application called 
"OziExplorer". Also, it's recommended that you have JMPS/Falconview with any 
map data that you will potentially want to add to your iPad, Adobe 
Professional, and a photo editor installed (i.e "Microsoft Office Picture 
Manager," which comes with Microsoft Office). 



Chapter II 
iTunes 

II. iTunes 

app
ITunes is the program that you 

lications, backup and update the 
will 
iPads. 

use to initialize new iPads, load 

1. iTunes Settings 

From iTunes, go to Preferences under the Edit menu, and select the 
Devices tab. Check the "Prevent iPods, iPhones, and iPads from syncing 
automatically" checkbox. This will prevent your iPads from backing 
themselves up and syncing automatically when connected to the computer. 

o fJeyent Podl. Phones. -t P-"s lrom syncing alAomalicllly 

o Yl~ lWlen [~~~[5!B oIlhe eMIl on !tis ~er wi be chllnged 

o Look lor !emote pllk_s COIYleCled with Aif'\lljI 
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Next, note the list of Device Backups. iPads will attempt to create a 
backup whenever they are synced. Backup is the best way to maintain 
standardization and replicate a common iPad image. For this reason, you will 
want to control when backups are created, and delete unnecessary backups. 

2. Downloading iPad Apps 
Before you load apps to an iPad, they must be downloaded to your iTunes 

computer. This requires unrestricted access to the iTunes store via the 
internet. In theater, this probably requires a special arrangement with your 
S-6/G-6 or the local WiFi contractor. In CONUS, until a better solution is 
realized, it is recommended this be done by the squadron iPad representative 



at an off base location. The reason for this is because iPads are not 
currently authorized on any USMC network. Only two things require access to 
the internet: downloading apps, and initializing a new iPad (see below). The 
recommendation is to do this at the same time as this will minimize the 
number of times you need to 
Once this is completed, the 
internet again. 

To download apps, open 
STORE 

menu. ICJ 1TU'1es Store Using 

connect the iTunes computer to the internet. 
computer shouldn't need to be connected to the 

iTunes and select "iTunes Store" from the left 

the search menu, find the following apps: 

• 
• 
• 
• BitMap ($2.99, required) 

GoodReader ($0.99, recommended) 

Adobe Ideas (Free, recommended) 

iAnnotate ($9.99, recommended) 

To purchase these apps, you will need to 
supply credit card information. Whose credit 
it's important to consider the following: the 
to the owner of that iTunes account. A single 

create 
card you 
apps you 

iTunes 

an iTunes account and 
use is up to you, but 
purchase will belong 

account can be 
associated with up to 5 iTunes computers. Once apps have been purchased on 
an account, they can be downloaded for free to another computer, provided 
that iTunes computer has been associated with the same account. To do this, 
select "Authorize this Computer" from the "Store" menu in iTunes. You will 
need the username and password associated 
with the account, and you will need to be 
connected to the internet. If you use 
personal accounts, as personnel swap out, 
you may need to repurchase the apps under 
another user's name. If you replicate an 
iTunes computer by "ghosting" the hard drive 
- you will still need to authorize the new 
computer, or download the apps again using a 
different account. 
Once the apps have been downloaded to your 
iTunes computer you will be able to install 
them on any iPads that you sync to this 
computer, following initialization of the 
iPad. 

3. Initializing a New iPad 
IPads will not turn on until they are 

first connected to a computer which is 
running iTunes and can connect to the iTunes 
store via the internet. With a new iPad, 
connect it to a computer running iTunes, and 
follow the prompts to initialize. Note that 
you do not want to register the iPad on the 
internet - cancel this step. If your copy 
of iTunes has already been used to setup an 
iPad, on subsequent iPad initializations, 
iTunes should ask you whether you want to 
use the existing image or treat this iPad as 
a unique device. Tell iTunes that you want 
to treat each iPad the same. Next, under 
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the checkboxes are checked to sync the various apps. 
At this point, select the Sync button to copy the apps to the iPad. 

If you've already backed up a good iPad image, you can replicate that image 
onto your new iPad by following the steps below under "Restoring / Updating 
an iPad". When you've got your first iPad set up as desired, follow the 
steps under "Creating a Backup and Version Control" to make a backup, then 
replicate your remaining iPads from that backup image. 

4. Restoring/Updating an iPad 
The backup feature of iTunes is an effective way to backup a good iPad 

image, use that image to restore malfunctioning iPads, or propagate changes 
to other iPads. This is simpler than making a series of changes to each of 
your iPads separately. Of note, the restore from backup does not copy new 
apps to an iPad. If you have apps in iTunes that need to be added to a 
particular iPad, first sync the iPad to install the apps. However, when the 
sync process begins, the first step will be to back up. You'll see the 
display below: 

lIunes 

Important: Immediately click the E3 to prevent an unnecessary backup from 
being created. On completion of the sync you will see the following message, 
which is fine: 

o iTlI'lea eot.Id not Mc:k \C> Ihe Pelf·~vr bec.IuIe !he Pelf 
chccnllCted. 

This just informs you that the backup is cancelled. 

When the Sync is complete, right click on the iPad (under "Devices") on 
the left pane, and select "Restore from Backup". Select the backup. These 
are listed by date and there should only be one if you delete old images . 

. .... 
Eject 

Sync 

Transfer Pl.rchases 
BackUp 
Restore from Backup... 

Reset W.arninncPLAYLIS'-- -_·-..... .....J 

The restore process will take 5-10 minutes. After it is complete, this iPad 
should be identical to the iPad from which the backup was made. 



5. Creating a Backup and Version Control 
The backup feature allows you to create a master "image" that can be used to 
easily update or restore your individual iPads. To create a backup, first 
make whatever changes (uploading new GRGs, changing iPad settings, etc.) are 
required to a single iPad. 
Next, it's beneficial to have a version displayed on the iPad to help with 
version control. The technique we use is as follows. The PowerPoint file 
"iPad Background with Version.pptx" is a single slide, with a wallpaper image 
for the iPad and a text box indicating the date of the most recent version. 
Change the date in the text box, and then select "Save As" from the file 
menu. Select JPEG from the file types drop down and hit Save. Next, make 
this image the wallpaper for the iPad. There's more than one way to do this, 
but one technique is to copy the file to the "My Pictures" folder under "My 
Documents" and use the sync photos feature of iTunes to move the photo to 
your iPad. From the Photos app you can set the wallpaper. If you want to 
subsequently delete the photo from the Photos app, you'll have to delete it 
from "My Pictures" and re-sync. (Once the photo is set as the wallpaper, it 
doesn't also need to be in the Photos app.) 

Once you've finished your improved iPad setup, to include indicating 
the version, return to iTunes, right click on the iPad on the left pane, and 
select "Back Up". 

E~ct The backup process may take 10-15 minutes. This 
.-.-----.--- will allow you to use the same image to replicate this 

S~ iPad's contents exactly, which is simpler and less 
~~~~~ error-prone than making detailed changes to each of 
~up your iPads separately. 
Restorefrom8adoJp... You may want to record the date and time of the backup 

image, in case another user creates a backup, or you 
R~WM~ sync another iPad and forget to cancel the backup 

process. With multiple backups saved in iTunes, the 
only way to differentiate them is the date and time the backup was performed. 



Chapter III 

Bit Map 

III. Bit Map 
Bit Map is an iPad app which is designed to use GPS to indicate your 

position and route on a map. What makes it unique is the ability to import 
your own map layers from geo-rectified picture files (JPEGs). Bit Map does 
not have all the features one would desire in a GPS app, but it does give us 
a moving map capability, together with a seamless GRG layer (no GRG 
boundaries), and a limited search functionality. 

Appendix (c) "Bit Map User Guide" and Appendix (d) "Bit Map Files 
Acquisition Guide" provide most of what users need to know about using and 
administrating Bit Map. This chapter covers some items unique to recent 
aircrew implementation. If you've been provided with zip files and maps 
ready-made for BitMap, follow the instructions under "Uploading Maps to Bit 
Map" to move these maps to your iPad. 

1. Producing Maps for BitMap 
Begin by assembling JPEG images of your desired map layer. In the case 

of GRGs in theatre, this means downloading the JPEG format from MCIA, or 
using Adobe Pro to save GRG PDF files as JPEGs. An important consideration 
is that each individual map image should be no more than 6MB. The save 
options in Adobe can be adjusted to create smaller (lower-res) JPEG files. 
Another technique is to use photo editing software like Microsoft Office 
Photo Manager to change the file size of the JPEGs. The tradeoff is always 
file size vs. resolution. 

In order to create a large map, create adjoining (overlap is ok) images 
below 6MB each. If you are producing a map layer other than GRG coverage 
(e.g., 1:100k), a good technique is to use the chart tool in JMPS/Falconview 
to produce adjoining pages of an appropriate size. Select Adobe as your 
printer to create a PDF, and adjust the page size to create the largest tiles 
possible, without exceeding 6MB per tile. From Adobe Pro, save the PDF as a 
JPEG. Adobe Pro will automatically produce one JPEG for each page. Note the 
size of the resultant files - you can adjust the page size in JMPS/Falconview 
to create larger or smaller tiles as necessary. 

Next, use OziExplorer (see Chapter IV) to geo-rectify the files (see 
Chapter IV) Once you have geo-rectified the files, you need to compress 
(zip) the JPEGs and .map files together. You can either compress a folder 
containing your files (the folder name will be the name of the map layer in 
Bit Map), or compress the files themselves (the name of the zip file will be 
the name of the map layer in Bit Map). You cannot, however, have multiple 
folders or subfolders in the compressed file. To create the zip file, select 
your folder (or the files themselves), right click, and select "Send To" -> 
"Compressed (zipped) Folder". Compressing the files may take some time. 
(For example a file which is 450MB and contains 267 GRGs, can take 4 hours). 

A key point is that the zip file you provide to Bit Map will constitute a 
single map (tiles in the zip are stitched together). These files should all 
be of the same scale (don't mix 1:50 and GRGs in a single zip file). 
Additionally, you cannot easily scroll left/right/up/down between different 
maps in Bit Map. In theatre as of June 2011, there is "North AO.zip" and 
"South AO.zip" files, but as the geo-rectified GRG coverage becomes gapless, 
the best solution is most likely to create a single zip file for all GRGs. 



If this file proves unwieldy due to size, look at creating multiple 
.zip files with overlapping zones of coverage (e.g., South AO.zip and North 
AO.zip which both include the Gereshk area), and be alert to the version 
control issues created thereby. 

2 . Uploading Maps to Bit Map 
This is well detailed in Appendix (d) "Bit Map Files Acquisition Guide", 

but the instructions on transferring files via USB are reproduced here. This 
is the simplest method and will work as long as you have the iPad computer 
and iPad collocated. 

1.	 Connect the iPad with Bit Map installed the laptop computer with iTunes 
running on it. 

2.	 In iTunes, select the iPad device when it appears in the panel at the 
left side of iTunes window. 

3.	 Select the "Apps" tab. 
4.	 Scroll down to the bottom of the Apps tab to the file sharing section, 

and select "Bit Map" in the list of file-sharing compatible Apps. 
5.	 Drag your map files (usually in a .zip file) or KML/KMZ files into the 

pane to the right. 
6.	 Wait for i Tunes to finish copying the file (s) to the device. 

7.	 Run Bit Map on the iOS device, then tap the l1li button on the top 

toolbar (if in the map view) to see the main tab bar, then tap the D 
(acquire) button on the main tab bar. 

8.	 Wait for Bit Map to process the files. 

Of note, be sure there is only one .JPEG file and one .MAP file of the same 
name per folder. More than one of either of these files will cause it to 
transfer to Bit Map improperly. 

To upload routes to Bit Map (KML files used to create a searchable sector 
and/or MGRS grid database), follow the exact same steps, except select the 

routes icon l1li from the bottom. Your .kml files don't need to be zipped as 
you can simply upload individual .kml files. 

3. Waypoints in Bi t Map 
Bit Map allows you to upload .KML files containing waypoints or routes. 

Really, Bit Map does not distinguish between the two. Waypoints in Bit Map 
can be searched for by name. Currently in theatre, this feature has been 
used in two ways. First, by uploading KML files with every sector in the AO, 
allowing you to quickly center the display on a given sector. Second, by 
creating KML files with every 4-digit grid in the AO (roughly speaking: 
lOO,OOOm zones PP, PQ, PR, PS, NP, NQ are represented) to allow you to center 
on a 4-digit grid. Note that KML files are uploaded in a very similar manner 
to maps (zipping not required, however). Appendix (c) offers an explanation 
as to how these files are set up. The procedures for uploaping waypoints are 
essentially the same as those for uploading maps. See "Uploading Maps to Bit 
Map" above. 



Chapter IV
 
OziExplorer
 

IV. OziExplorer 
OziExplorer is an application which has a variety of features relating to 

GPS and the use of user supplied map imagery. For our purposes, it is useful 
in that it allows you to easily crop and geo-rectify images of maps and GRGs. 
The Bit Map app on the iPad is designed to work with the .map files that 
OziExplorer produces. 

1. Using OziExplorer to Georectify an Image 
When you geo-rectify (or "calibrate") an image with OziExplorer, the program 
will produce a file called "filename.map" where "filename" is the same name 
as the image file. The .map file is a small text file with instructions 
regarding the cropping and geographical location of the image. You will want 
to save the .map file in the same folder as the original image. Ultimately 
you're looking create a .zip file containing a number of map images (JPEGs) 
and corresponding .map files, for upload to Bit Map. Note that your only 
indication that an image has already been geo-rectified is the existence of 
the .map file so if you're working with someone else's work, look for which 
.map files are missing and start there. Below are step by step instructions 
to geo-rectify an image. 

1.	 Open OziExplorer 
2.	 Under the File menu, select "Load and Calibrate Map Image" 
3.	 Select your JPEG. This could be a GRG, or any other JPEG of a map 

(e.g., produced via JMPS/Falconview and Adobe). 
4.	 The image will load with the Calibration menu on the right side. 

5.	 Click the Corner Markers icon to crop the image: [~l 
6.	 Place the corner markers on all four sides to crop the margins off. 

Use the small zoom window to get the placement just right. The GRG 
borders are generally depicted as dashed lines, and you can see there 
is a very small overlap between GRGs. Try to get as much of the image 
as possible (including the overlap area) without including any 
whitespace or the black border around the GRG image. 

7.	 Next, ensure the "Map Projection" is Latitude/Longitude. Map 
projection tells OziExplorer what constitutes a straight line across 
your image - a line of lat/long or a UTM/MGRS grid line. In the case 
of a GRG, the area is so small it doesn't matter. What does matter is 
that if you select UTM, BitMap will round the borders to the nearest 
100m, which will ruin the edge matching. With Latitude/Longitude 
selected, BitMap will not round and your edges will match. 

8.	 Next, you will place 3 points on the image with UTM grid coordinates. 
Although you can read lat/lon intersections off some GRGs, do not use 
these to georectify the image. It is important to use UTM grids, 
based off the MGRS gridlines depicted on the GRG. 

9.	 Select the Point 1 tab. 
10.	 Click on the map at your desired grid line intersection. Use the 

zoom window to be as accurate as possible. 



11. Next, type in the UTM grid. For a brief explanation of UTM, see 

below: 

Universal Transverse Mercator (UTM) 

MGRS is derived from UTM and they are very similar. The Grid Zone (e.g. 41R) 
is the same in UTM. However, a common convention is to use "N" or "S" for 
the letter portion, based on whether the zone is in the North or South 
hemisphere. The rest of the UTM grid will eliminate any ambiguity. 
OziExplorer uses this convention, so our AO is 41N vice 41R and 41S. 

The 100,000m identifier (e.g. PQ in MGRS) is replaced by numbers. A single 
digit is prefixed to the easting, and a two-digit number is prefixed to the 
northing. For example, the PQ region uses numbers 6 and 34. Thus, 41R PQ 
12345 67890 is, in UTM, 41N 612345 3467890. A "10 digit grid" (1 meter 
accuracy) will always have 6 digits for the easting and 7 digits for the 
northing. OziExplorer is looking for 1 meter grids, so if you pick "4 digit" 
gridline intersections, you'll end up with something like 41N 612000 3467000 
(that's PQ 12 67). 

In	 practice the takeaway is that the 100,000m identifier (PQ, PR) will 
determine the numbers to prefix to your northing and easting. The MGRS 
Converter application can convert from MGRS to UTM, and JMPS/Falconview can 
also be set to display UTM grids in the lower right corner. 

12.	 One you've filled in the grid, be sure to select the next Point 
tab (Point 2 or Point 3) before clicking on the map again. Otherwise 
you'll change the reference point for the Point you just worked on set 
yourself back a step. 

13.	 Once 3 points have been defined, click "Save". The calibration 
menu will go away. 

14.	 You have just created a ".map" file that specifies the cropping 
and coordinates for the image. This file will automatically have the 
same name as the image (which is what you want) and should be saved in 
the same folder as the image. 

15.	 The next step is important to check your work. Select "Grid Line 
Setup" from the Map menu. 

16. Select the "Other Grid" tab. 
17.	 Check "Grid On". The settings should look something like the 

picture below. If not, adjust them and select "Default" to save those 
settings as the default. 
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18.	 This should display grid lines (blue for the lkm grid lines) 

across the image, with labels. If these lines match up closely with 
the lines on your map, you've calibrated correctly. If you made an 
error when specifying points in the calibration phase, the lines will 
not match up, will not display, or will be skewed in some fashion. 

19.	 If the grid lines do not look correct, select "Check Calibration 
of Map" from the File menu. The calibration menu will return. Check 
your work, hit save and overwrite the previously made file. 

20.	 Once the grid lines match, you're ready to repeat the process 
with another file. 

2. Using OziExplorer to Add Grid Line Labels to a GRG 
On many GRGs the grid lines are only labeled on the margins. A result of the 
geo-rectification process is that marginalia will not be displayed, so it is 
important to add labels to the grid lines for display in BitMap. In 
principle, this just requires you to edit the JPEG image with the desired 
markup. Below is described a relatively simple method of doing this using 
OziExplorer. This process is far less tedious and time intensive than using, 
for instance, Photoshop to add all the desired labels. The process below 
must be conducted after the GRG has been geo-rectified. 

3. Background - Waypoint Files 
OziExplorer supports loading waypoint files (which are text files) in order 
to display waypoints at desired locations on a geo-rectified image. This 
feature is used to create grid line labels. For a detailed discussion on 
adding waypoint files to OziExplorer, please see Appendix (e) "Combat iPad 
Administration Manual." 



Chapter V
 
GoodReader
 

V. GoodReader 
GoodReader is a general purpose file-viewing application, capable of 

viewing images, PDFs, and any number of other file formats. For our 
purposes, it is handy in its ability to display HTML files with hyperlinks to 
other files within GoodReader, its handling of large images, and its ability 
to organize files into a folder structure. Before we found Bit Map we used 
GoodReader exclusively to view GRGs. With Bit Map installed, GoodReader may 
be obsolete for GRG viewing. However, at the moment there are more GRGs in 
GoodReader than there are geo-rectified GRGs in Bit Map. Ultimately it is a 
good place to store any documents that may be useful in the cockpit (NATOPS, 
JFIRE, etc.), as well as GRGs that you haven't been able to geo-rectify yet. 

1. Uploading Files to GoodReader using iTunes 
There simplest way to upload files to GoodReader is via iTunes and the 

iPad's USB connection. This section will actually apply to any iPad app that 
supports file syncing through iTunes. First, connect an iPad to a computer 
running iTunes. Select the device from the left pane, then select the "Apps" 
tab. Scroll down to the "File Sharing" portion of the page, then select 
GoodReader to see the display below: 
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Click the "Add.. " button or drag files into the GoodReader Documents 
display to send them to GoodReader. File sharing in iTunes is primitive in 
that you can only send files, not folders, and you can't put files into a 
specific folder within GoodReader. Even though folders are displayed ("1. 
Spot Maps", etc.), files you add using this technique will always go into the 
root directory of GoodReader. 

A good technique if you need to copy numerous files into GoodReader is 
to zip them and move the single file over. Next, from your iPad, open 
GoodReader. You should see the file you just uploaded on the left (in this 
example, "KJK.zip"). Tapping on the file will give you the option to unzip 
it. 



Also, by selecting "Manage Files" on the right, you'll see a number of 
options to include copying, moving, and renaming files or folders. You can 
use these options to migrate the uncompressed files to their desired 
destination. 

2 .	 Using GRGs in GoodReader 
The use of spot maps is covered below, but first we'll look at viewing 

GRGs themselves in GoodReader. Accessing and viewing the files is very 
straightforward. The iPad tutorials cover other user steps such as copying a 
GRG to Photos for faster access. A few administrative considerations are in 
order here. First, GRGs in theatre are generally distributed by MCIA on 
their SIPR website as PDFs and JPEGs. The PDFs are generally 65MB in size. 
While these are viewable in GoodReader, the performance will be very slow. 
One solution for this is using a different app, called "iAnnotate PDF", which 
has very fast performance and allows you to mark-up the GRGs. The other 
route is to use GoodReader. GoodReader uses JPEG versions of the GRGs, which 
generally load faster. However, the JPEGs provided by MCIA are generally 4­
5MBs in size. GoodReader takes about 1 second per MB to load an image, 
giving you about 5 seconds to pull up a full-size GRG in JPEG format. 
Additionally, 5MB GRGs do not perform well when ported to Photos, or used in 
Adobe Ideas (used to draw on the GRG). For these reasons, some squadrons 
choose to compress the GRGs to I-2MB. The free photo management program 
Picasa was used, and the specification for compressing the JPEGs was to limit 
the long axis to 4000 pixels. Many other photo programs can be used to 
compress GRGs. Ultimately the tradeoff is resolution vs. performance. 4000 
pixels is an acceptable compromise, with load times of about 1 second and 
resolution generally equivalent to or better than a printed map. High 
resolution GRGs have also been added to GoodReader but it is important to 
inform aircrew that the export to Photos feature will not work well with the 
high resolution GRGs. 
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UNITED STATES MARINE CORPS 

~I
 
2D MARINE AIRCRAFT WING (FORWARD)
 

II MARINE EXPEDITIONARY FORCE (FORWARD)
 
UNIT 78091
 

FPO AE 09510-8091
 
IN REPLY REFER TO: 

5000 
G-6/CND 
26 Apr 11 

From: Commanding General, 2d Marine Aircraft Wing
 
To: Distribution List
 

Subj: 2D MARINE AIRCRAFT WING IPAD USE POLICY 

Ref: (a) WgO 5239.1 
(b)	 Interim Authority to Operate (IATO) the iPADs in the United States 

Marine Corps (USMC) aircraft for training in preparation for combat 
and in combat operations: 2011-0423 

Att: (1) 2D MAW iPAD User Agreement 

1. General. Effective immediately. 

2. Situation. To provide policy for the use of iPad devices
 
within 2d MARINE AIRCRAFT WING (2D MAW) .
 

3. Mission. In order to improve safety and prepare for deployments into 
theaters where they are currently being utilized, iPads are being procured 
for rotary wing and fixed wing squadrons in CONUS. The primary use of the 
iPads will be as electronic map boards to replace the multitude of maps that 
the pilots must currently reference with a single source point of 
information. 

4. Execution. iPads are not accredited for use on any 
government network, and have not undergone any type of information assurance 
testing. Therefore, their use will be limited by the following restrictions: 

a. iPads will not be connected to any government network, to include 
SIPRNET, NIPRNET, and CENTRIXS-ISAF networks. Any data loaded to the iPads 
will be transferred from a stand-alone computer. 

b. Stand-alone computers will be brought into the 2d MAW G-6 Computer 
Information Assurance section for virus and operation system updates at a 
minimum of every (45) days. 

c. The wireless, 3G and Bluetooth devices internal to the iPad will 
remain in the "off U position at all times. These services will be disabled 
and password protected by the local 
S-6 representatives. 

d. iPads will not process classified information. Data 



processed on the iPads will not be marked or manipulated in any way that 
renders that data classified. The processing of classified information on an 
iPad will be considered a security violation. 

e. iPads will not be supported by the 2D MAW G-6. If software or 
operating system support is required, it will be provided by the 
manufacturer. As commercial, off-the-shelf equipment, all maintenance for the 
iPads will be handled directly with the manufacturer. 

f. iPads have to be bought through a government 
Information Technology purchase process. No personal iPads will be used in an 
official capacity. 

g. CD/DVDs and hard drives used in the transfer of 
information between the standalone station and network devices must be 
checked for malware by running an antivirus scan using current definitions. 
Antivirus software and definitions may be acquired from 2d MAW G-6 Network 
Defense section. 

h. The use of the Apple Application Store is strictly prohibited. 
The applications available via this Application Repository have not been 
certified via IA procedures and may possibly contain viruses and or malware. 

i. Government owned iPads will NOT be connected and or synced to 
personal computers. This poses a possible risk of information leakage from 
the devices to the world wide web. Additionally, these devices will not be 
used to store and or play personal media such as music and or movies. 

5. Administration and Logistics. iPads will be received and 
accounted for by the requesting unit Supply Section, and then sub-signed via 
CMR to the rotary wing and fixed wing squadrons as required. 

6. Command and Signal. The point of contact for this policy is 
the 2d MAW G-6 at DSN: 582-2366 Commercial: (252) 636-2366. 

J.M. DAVIS 

DISTRIBUTION: A 



Appendix B 

2ND MARINE AIRCRAFT WING, IPAD USAGE AGREEMENT 

Your signature below verifies that you have read and understand the iPad usage policy and the guidelines, procedures and 
responsibilities outlined below and agree to comply with them. 

Guidelines: 

I) All users issued a Government iPad must sign a iPad user agreement form.
 

2) Use of a Government iPad device is for Government business only.
 

3) Government iPads will be connected only to a designated stand-alone computer.
 

4) Government iPads will NOT be synced with personal computers.
 

5) Use of any wireless, to include 3G and Bluetooth services, is prohibited.
 

6) Only iPads and services outlined in the iPad contract(s) will be permitted.
 

7) No downloading of songs, applications, videos or any other items to Government iPad.
 

8) Government iPad users shall not "loan" or otherwise make available their iPad to non-Marine Corps personnel.
 

9) Government iPad users are responsible for services received on their respective devices.
 

User Responsibilities: 

I) Improper use of the Government iPad can be considered misappropriation of Government funds which may result in 
disciplinary action. 

2) A Government iPad user must surrender the iPad to the local unit supply upon termination of duties with the unit (i.e. 
retirement or PCS/A). At this point, no further use of the iPad is authorized. Transferring the iPad to the incoming replacement 
is not authorized unless it is conducted at the local Unit Supply Office. 

iPad Assigned serial number: _
 

iPad User: Date:
 
PRINT SIGN -------- ­

Supply Chief: Date: _ 
PRINT SIGN 

Date returned to Supply: Supply Clerk Name: -=--=--=-=- ---::-----::-c:--,-- _ 

PRINT SIGN 



Appendix C 

Bit Map User Guide
 

Tap the Bit Map button on the iPhone home screen to start Bit Map.
 

Bit Map begins by displaying the last used map or otherwise the first map it finds.
 

For new users, the bundled world map will be displayed and a message will appear explaining how to make the 
toolbars re-appear after they auto-hide. 

Acquiring Maps (Getting Maps Into Bit Map on the iPhone) 

Bit Map includes only a very basic world map, and is designed for you to view your own maps from a wide variety 
of map sources. Before you can make any substantial use of Bit Map, you'll need to install your own maps. For 
instructions on installing your maps, please refer to the: 

Files Acquisition Guide (for map image files and KML route/waypoint files) 

Viewing Maps 

Bit Map begins by displaying the main map view and the map view's toolbars. After 5 seconds, the toolbars will 
disappear in order to better view the map on the entire screen (toolbar hiding can be disabled in settings). Tap the 
screen once to make the toolbars re-appear in order to access other functions. 



Map View with Toobars Map View without Toobars 

Pan and Zoom 

The map can be scrolled and zoomed by dragging and pinching. 

Double-tap with one finger to zoom in 2x, or with two finger to zoom out 2x. 

Tripple-tap with one finger to zoom back to the map's natural default scale. 

By default, if you zoom in or out by more than 4 times the default scale factor, Bit Map will automatically 
switch to another map with a finer or coarser scale if it can find another map covering the same location. 

Switch Maps 



mQui'kly 'yde through all avilahle maps using the pcevious and noxt buttons on the top toolba,­

__Quickly switch to the next available map of the same location with a finer or coarser scale using the 
_ plus and minus buttons on the top toolbar. 

AdditionaIly, the Maps Manager can be used to select a map from a list of instaIled maps explicitly (see 'Managing 
Maps' below). 

The name of the current map will be displayed immediately above the bottom toolbar when the toolbars are visible. 

Follow Location On Map 

lfthe current location is on the map being viewed, it will be marked with a cross-hairs symbol (with a translucent
 
red circle indicating the accuracy of the location reading). Additionally, Bit Map uses its 'FoIlow' mode to
 
automatically scroll the map to keep the current location centred on the screen.
 

iJ Use the foIlow button on the bottom toolbar to tum 'FolIow' mode on and off. A tick (check mark) or a II cross on the button indicate whether folIow mode is on or off; a '1' (question mark) indicates that the current 
location is unknown. 

While in foIlow mode: 

•	 If your current location moves off the edge ofa map and an alternative map is available in the same map set 
that does include your current location, the maps are automaticaIly switched so that your location will be 
displayed on the alternative map (can be disabled in preferences). 

•	 Device sleep is disabled if the device is also connected to a power source. 

Record Waypoints 

Bit Map can record waypoints of locations and keep waypoints organised in routes. A 'route' is a stored group of 
waypoints. The 'active route' is the route to which any new waypoint wilI be added. If there is no 'active route' 
when a waypoint it taken, a new route named after the current date and time will be created which the waypoint (and 
future waypoints) will be added. 

Save a waypoint for the current location using the (push-pin) save waypoint button. The waypoint will be 
~ saved to the active route, and the waypoint editor will be displayed. Tap 'Done' to confinn the waypoint or 
~ 'Delete' to cancel the waypoint. Optionally, before tapping 'Done', the waypoint can be given a name and a 

note, and the coordinates can be changed if desired. The name will be displayed on the map when this 
waypoint or route are selected for map display (the active route is displayed on the map by default). 

Save a moving waypoint, initially in the centre of the screen, but which can be touch-dragged to anywhere 
on the map. When it has been moved to the preferred location, double tap the moving waypoint to make it a 
nonnal (fixed-position) waypoint. Names and notes can be added to the waypoint using the Route­J:i >Waypoints detail views (see below). 

Tum automatic waypoint recording on and off using the (3 push-pin) auto on/off button. While automatic 
E:J!i recording is on, waypoints will be automatically saved periodically (according to the settings in preferences. 
~ A tick (check mark) or a cross on the button indicate whether recording is on or off. The active route will be 

displayed at the bottom of the map view while recording is on, even when the toolbars are hidden. 



WARNING: While automatic waypoint recording is on, the device's GPS receiver will operate continuously even 
when Bit Map is quit or when the device is asleep, so that Bit Map can keep running and recording waypoints in the 
background. This will consume battery power quite rapidly. Make sure you turn off automatic waypoint recording 
when it is not absolutely necessary, and there is not likely to be an opportunity to recharge the battery soon. 
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Recorded Routes & Waypoints Displayed on Map 

Search for Waypoints or Routes 

• Tap the Search button to display a search bar which can be used to search for wayoints and routes by name. A
Iii1 selected result can be then be displayed on the map. 

Type text into the search bar's text field, and the search results will appear in a dynamically updating table as you 
type. Tap the 'Routes' button or 'Waypoints' button to switch between searching for routes or waypoints 
respectively. 



Tap a found waypoint or route to display it on the map (or if it is not on the current map, it will be displayed on 
another map if it can be placed on any of the available maps). The selected waypoint or the starting point of the 
selected route will be displayed on the centre of the map. 

Viewing Current Information 

Tap the Info button to view various information of interest. Several items can be displayed here, including i coordinates, speed, distances. Use the Info Panel view in Settings to control which items will be included inmthe Info panel (see below). 

Settings and More 

To access the other features of Bit Map, including Settings, Maps Manager, Routes Manager, tapping the More 
(dots) button on the top toolbar in the Map View. 

IIThe "ttings and mnre bulton willeave tbe map viewee to """ the othee feature' of Bit Map. 

This will display a tab bar along the bottom of the screen. Tap the 'View Map' item to return to the map viewer. 

Manage Maps 

In the map viewer, tap the more button (3 dots), then the 'Maps' item to display the maps manager. The maps 
manager displays a list of map sets Gust the default map set for new users). Each set can contain several maps. 

Browse Map Set 

Tap on one of the map sets in the list to view a list of all the maps in that set. Tap the 'Map Sets' button to return to 
the list of all map sets. 

Rename Map Set 

Tap on the 'Rename Set' button while browsing a map set to change its name. Tap 'OK' or 'Cancel' to confirm or
 
cancel the change.
 



Sort or Re-Order Map Set 

Tap the 'Sort' button while browsing a map set to re-order all the maps within the set into alphabetical order. 

Use the 'Edit' button and then the drag handles for each row to drag maps into a custom order. 

View Map 

Tap on one of the maps in a map set's list of maps to view that map in the map viewer (if it was not the last viewed 
map Bit Map will either centre the view on your current location on the map (if available) or on the centre of the 
map). 

Install Maps 

Additional maps can be installed using the 'Acquire' (+) button on the bottom toolbar. New maps will be added to 
the 'New Maps' map set. See the Acquisition Guide for instructions on how to install maps on Bit Map. The 
bundled maps can be re-installed (if they've been deleted) by tapping the 'Bundled' button at the top of the screen. 

Move Maps 

While browsing the map set from which the map(s) to be moved currently belong, tap the 'Move Map(s)' button. 
When the destination map set selector appears, you can select a map to move, if moving only one map, then select 
the destination map set, then tap 'OK'. If you did not select a map to move, then all maps in the current set will be 
selected for moving. Tap the button to confirm (or cancel) the move. 

Re-order Maps 

Use the 'Edit' button to enable the re-order control next to each map. Tap (hold) and then drag a map to move it to 
another position in the table. 

Delete Maps 

Use the 'Edit' button or swipe gesture to display a 'Delete' button next to each map while browsing a map set. Tap 
the 'Delete' button next to a map to permanently remove it. 

Delete Map Sets 

Use the 'Edit' button or swipe gesture to display a 'Delete' button next to each map while viewing the list of map 
sets. Tap the 'Delete' button next to a map to permanently remove it. Only empty map sets can be deleted. 



New Map Set 

Use the 'New' button while viewing the list of map sets to create a new map set. A view will appear where you can 
change the map name. Tap 'OK' to confinn or 'Cancel' to cancel the new map set name change. 

Manage Routes 

In the map viewer, tap the more button (3 dots), then the 'Routes' item to display the routes manager. The routes 
manager displays a list of all stored routes (ie, series or groups of waypoints). 

Adhoc locations (2 points) 

Routes Manager 

Ifthere is currently an 'active route', it will be displayed in the table header. It will also have a grey background to 
its table cell. If the active route is being displayed on the map, its text will be shown in the route's display colour 
(yellow by default). 



Any other routes displayed on the map will have their table cell shown in their display colour (ie, the same colour in 
which the route and its waypoints will be displayed on the map). Routes not currently displayed on the map will be 
shown with a white cell. 

To select a different route as the active route (ie, the route to which new waypoints will be added), tap the blue 
disclosure button to the right of the route name, then tap the "Activate" button on the top of the Route's detail view, 
then tap 'Done' to return to the Routes view. 

To showlhide a route on the map view, tap it to toggle its displayed status. It will toggle between coloured and 
white to indicate if it is displayed on the map view or not. 

Use the 'New' button to create a new route and display the route editor (see 'Edit a Route', below). 

The 'Send All' button in the Routes Manager will present a mail view in which you can enter an email address (or 
several email addresses) to send all of the stored routes to as KML attachments (one attachment per route). These 
KML files can be used in a variety of desktop applications, including Google Earth, to display your route, including 
labels for named wayoints. 

Use the '+' (acquire) button to display Bit Map's acquisition view, from which you can acquire KML files from a 
desktop/laptop computer, or from a web server. Use the acquisition view to install KML files in exactly the same 
way as it is used to install map image files. KML files will be converted into Bit Map routes and waypoints. See 
the Acquisition Guide for details on importing KML files into Bit Map as routes. 

Edit a Route 

Use the blue disclosure (» button next to a route name to edit an existing route in the route editor. 

Using the route editor, the route can be renamed (default name for new routes is the current date and time). The 
route editor also shows a colour selector from which the colour for the route can be chosen (Yellow, Red, Green or 
Blue). A routes colour is used for its background in the table on the Routes view as well as for the display of the 
route on the map, and in the exported routes (KML) which can be viewed in Google Earth and a variety of other 
applications. 

By default, a route will be displayed as a series of points (for each waypoint recored) connected by lines. Either the 
lines or the points can be switched off to avoid having them displayed using the 'Lines' and 'Points' switches. NB: 
Points will always be displayed for waypoints with a name. 

Use a swipe gesture or the 'Edit' button to display 'Delete' buttons next to the waypoint, then tap a 'Delete' button to 
delete a waypoint. 

Tap a waypoint to show the map view with the waypoint displayed on it (if a map which covers that waypoint can 
be found). 

Tap the blue disclosure (» button next to a waypoint to edit the details of that waypoint (name, note, coordinates). 
Use the 'Centre' or 'Move' buttons in the Waypoints view to tum it into a moving waypoint which can be touch­
dragged on the map view (,Centre' also centres the waypoint in the screen first) - double tap the moving point on the 
map to tum it back into a normal fixed waypoint again. 



Acquire Maps or Routes 

In the map viewer, tap the more button (3 dots), then tap the the 'Acquire' (+) button to install additional maps or 
routes. See the Acquisition Guide for detailed instructions on how to install maps and routes in Bit Map. 

Settings 

Settings can be used to change some of the default behaviours of Bit Map. 

In the map viewer, tap the more button (3 dots), then the 'Settings' item to display the settings (preferences) view. 
The settings view lists the various categories of settings. Tap a category to view or change settings in that category. 
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Map Display 

Auto Hide Map Toolbars 

This switch controls whether the toolbars on the map view are automatically hidden after 5 seconds or stay on the 
screen permanently. 



Use Low-Res on High-Res Screen 

For users with high resolution screens (such as the iPhone 4's 'retina display'), the map is normally shown at high 
resolution in order to be able to view more of the map on the screen at once, without any loss of quality. However, 
if you wish the map to be displayed at the same lower resolution as on other displays, set the 'use low res on high-res 
screen' switch to ON. 

Import & Optimisation 

UTM .map Calibration Rounding 

When .map calibration files specifY coordinates for UTM maps in latitude/longitude, they can sometimes be a bit 
inaccurate. Use the 'UTM .map calibration' value to have these coordinates automatically rounded to the nearest 
significant UTM coordinates (in metres). Eg, if you know that your map boundaries are always on 1000 metre UTM 
boundaries, set this value to 1000. This setting only affects UTM maps with .map calibration files at import time. 

Optimised Map Tile Image Format 

When maps are imported they are divided into tiles for better use of RAM when displaying. This setting controls
 
which image format is used for these tiles. JPEG uses less storage space, but has lower display quality than PNG.
 

This setting does not affect OZF2 or OZFX3 images which are already tiled internally.
 

JPEG Tile Image Quality
 

When using JPEG format for image tiles, this setting determines what JPEG compressionlquality setting is used.
 
The higher the value, the higher the image quality, and the more storage space it will use.
 

Automatic Map Switching
 

Use the three 'Switch to Another Map When.. .' buttons to enable/disable automatic map switching for zooming
 
and/or for when you move onloffthe edge of the map while in Follow mode. Automatic map switching when 
zooming and when moving off the edge of a map (while follow is on) are both on by default. Map switching when 
moving on to the edge of another map with a finer scale (while follow is on) is offby default. 

When automatic map switching is enabled, Bit Map will automatically switch to an alternative map, if a more 
suitable alternative can be found for the focal location in the same map set as the current map. 

Zoom In/Out More than 4 Times 

If map switching is on for zooming, Bit Map will automatically switch to a map with a coarser scale when you zoom 
out more than 4 times the default scale of the current map, or switch to a map with a finer scale when you zoom in 
more than 4 times the default scale of the current map (if such a map can be found in the current map set). 

Move off Edge of Current Map 

Ifmap switching is on for when you move off the edge of the current map so that your current location is no longer 
on the current map, and follow is enabled, Bit Map will automatically switch to another map that does include your 
new location (if such a map can be found in the current map set). 

Move Onto a Finer Scaled Map 



If map switching is on for when you move onto the edge of another map with a finer scale than the current map, then 
Bit Map will scan all maps in the current map set every time your location changes, and if it finds any maps in the 
current map set with a finer scale than the current map that includes the new location, it will switch to the map with 
the finest scale that includes the current location. 

Only Switch to Maps in Same Set 

This switch controls whether automatic map switching can switch to a map that is not in the same set as the current 
map or not. 

Automatic Waypoint Recording 

The 'Auto Waypoints' settings control how often Bit Map will automatically record waypoints when Auto 
Waypoints are on for the active route. The default is to automatically record waypoints every minute or every 100
 
metres, whichever comes first.
 

Minutes Between Points 

If a location change has been detected, a new waypoint will be automatically recorded if this number of minutes has 
elapsed since the last waypoint has been detected. 

Metres Between Points 

If a location change has been detected, a new waypoint will be automatically recorded if the distance between the 
last waypoint and the new location is greater than or equal to this number of metres. 

Required Accuracy 

If the location reading does not have an accuracy at least as good as the accuracy value set here, the waypoint will 
not be recorded automatically, regardless of the other automatic recording settings. However, you can still record a 
waypoint manually, using the buttons on the map view, even if the accuracy is poorer than this setting. 

Info Panel Components 

Each of the items in this settings view controls whether the item described will be displayed on the optional info 
panel or not. The info panel can be enabled/disabled using the "i" button on the map view. 

Additionally, there are two further switches which control how location information is displayed in the info panel:
 

Use UTM Grid Refs for Locations
 

If this switch is on, locations will be displayed in UTM grid references, instead oflatitude/longitude coordinates.
 

Use Map Datum for latllon Coords
 

If this switch is on, the datum of the currently displayed map will be used for latitude/longitude coordinates in the
 
Info panel, instead ofthe default WGS84 datum.
 

Note that for UTM grid references, the maps datum is always used.
 

Map and Image Compatibility
 



See the Files Acquisition Guide for lists of compatible map projections, datums and image formats. 

The maps used for the Bit Map icon and screenshots are derived from Geoscience Australia's free maps 
http://www.ga.gov.au/mapconnect/ © Commonwealth of Australia 2009 used by permission. 



Appendix D 

Bit Map Files Acquisition Guide 

Bit Map uses your own maps, therefore it is necessary to acquire, prepare and install your maps on Bit Map on your 
iPhone before you can use most of Bit Map's features. 

This guide explains how to load your maps onto your iOS device in such a way that Bit Map can use them. 

Bit Map can also read KML & KMZ files and use them for Waypoints and Routes (sets ofwaypoints). This guide 
also explains how to load KML & KMZ files into Bit Map. 

Introduction 

Once you have obtained your maps in digital form (eg, by scanning paper maps, or downloading them from a 3rd 
party), there are three steps involved in loading them into Bit Map on your iOS device: Optimisation, Calibration 
and Installation. 

Conversion means saving the image file in a file format that Bit Map can read. If your map files are not already in a 
suitable format, you may need to convert your image files into a compatible format on your desktop/laptop computer 
first. 

Calibration defines the area of the Earth represented by the map in a way that can be read by Bit Map. Bit Map can 
use two different calibration methods. 

Installation is the process of loading map image files into Bit Map on the iOS device. Bit Map provides four 
different ways of installing the files onto the iOS device. 

Each of these three steps is explained in detail later on in this guide. 

Limitations 

Currently Bit Map has some limitations with the map images it can import: 

•	 North should be directly up. That is, the (true) north-south axis should be parallel to the sides of the map. 
If this is not the case, the the map will not calibrate correctly, and locations accuracy will be reduced. 

•	 Only the projections listed at the end of this guide are supported. Any other projections will be imported as 
though they were latitudellongitude and will therefore have reduced accuracy for locations. 

•	 Only the image file formats at the end of this guide are supported. Other formats must be converted to one 
of the formats listed there before they can be imported. 

•	 Only the datums listed at the end of this guide are supported. Any other datums will be imported as though 
they were WGS84 and therefore may have reduced accuracy for locations. 

•	 UTM maps cannot cross UTM zone number boundaries. Such maps will be imported as latitude/longitude 
instead, and will therefore have reduced locations accuracy, and will not be able to be merged with other 
UTM maps of the same zone. 

Optimisation 



Bit Map can import a variety of image file fonnats including JPEG, PNG and OZF2 (non-RC4 only). See below for 
a complete list of compatible fonnats. If your images are already in a compatible fonnat, then you may not need to 
do any optimising, as Bit Map can probably optimise the files itself during import. However, doing image 
optimisation before importing is highly recommended (except for OZF2 files which are already internally 
optimised). Using pre-optimised files (or using OZF2 files) avoids the need for Bit Map to do this optimising during 
import, and therefore avoids the RAM problems and lengthy import times that can occur when Bit Map does the 
optimisation itself on the iOS device. 

For any unsupported fonnats (eg, ECW), the images must be converted to a compatible fonnat first. PNG is the 
recommended fonnat as it is high quality and still uses good compression. Many common desktop graphics 
applications can do this for you (eg, the GIMP is free and available for many operating systems, or Graphic 
Converter on Mac OS X supports even more fonnats). 

Pre-Optimisation on Desktop or Laptop Computer 

Note that optimisation is not necessary for OZF2 images (in which case you can skip this step and move on to 
Calibration and Installation). 

There are 3 methods to optimise your compatible image files before importing into Bit Map. Choose the method 
that best suits your files, your available operating systems and your needs: 

Online Bit Map Tiler Service (Experimental) 

This method is available on all operating systems, but is restricted to 7MB files, and I file at a time. 

I.	 On your desktop/laptop computer which has the image file stored, open a web browser window and browse 
to the URL: http://bitmap.nixanz.comltiler.php 

2.	 Use the fonn on that page to select and upload your image file. 
3.	 After a uploading and processing, the pre-optimised image will be automatically downloaded as a .zip file 

which can be imported into Bit Map. 

Bit Map Imager (Mac OS X Only) 

This method is only available for Mac OS X users, but also provides image viewing capability. This method also 
provides conversion/optimisation and viewer ofOZF2 image files (non-RC4 only). 

1.	 If you have not already done so, download the Bit Map Imager application from: 
http://bitmap.nixanz.com/BitMapImager.zip , unzip it, and copy the unzipped application to /Applications 
(or where ever you wish to store it). 

2.	 Run the Bit Map Imager application and open your image file in it (File->Open, or drag/drop). 
3.	 Choose File->Save or File->Save As, then in the dialogue window, choose 'Bit Map Optimised Image' from 

the 'File Fonnat' popup menu, then click 'Save' to save an optimised version of the image (it will save to a 
folder with a ".bitmap" filename extension - the entire folder should be imported into Bit Map). 

Tiler PHP Script 

This method can handle large image files, and can do batch conversion of multiple image files, however it requires 
the use of the command line (eg, using a "Tenninal" application). This method will run on Mac OS X, Linux or 
Unix systems with PHP installed with the GD extension (ie, most PHP installations). It is currently untested on 
Windows and would probably require minor changes to work correctly on Windows. 

1.	 If you have not already done so, on your desktop/laptop computer which has the image file stored, open a 
web browser window and download the file at http://bitmap.nixanz.com/tiler.zip and unzip the file. 



2.	 Run the script on the command line as follows: php tiler. php where is the directory/folder in which 
the optimised files should be stored and is the path to one or more image files. Each optimised image will 
be saved to a folder with a ".bitmap" filename extension - the entire folder should be imported into Bit 
Map. 

Calibration 

There are two methods of calibrating map files: 

The fully manual preparation method requires you to determine and define the region of the Earth covered by each 
map yourself, and to rename each image file using a strict format to define each map's area. 

The .map method uses OziExplorer-compatible ".map" files to automatically determine the area covered by each 
map, but is only available to OziExplorer users, or people who've obtained maps with associated ".map" files in 
OziExplorer format. 

Manual Calibration Method 

This method can be a little tedious, but is available to all users. OziExplorer users (or anyone with maps in 
OziExplorer format) may prefer the quicker and easier (but experimental and not fully supported) '.map Calibration 
Method' (below). 

Before you begin, you must determine the following information for each map: 

•	 Map Datum (eg, WGS84, AGD66, GDA94) 
•	 Grid references in UTM eastings/northings for the bottom-left and top-right comers of the map 

In addition for UTM maps, you may need to determine: 

•	 UTM Zone (eg, SSG, 56J) 

All this information should be available on the map itself, or from the source the map was obtained from. 

First you must obtain your maps in a compatible image file format (see list offormats, below). To do this you can 
scan your paper maps, or purchase map image files from a retailer (eg, Tasmanian maps by Tasmap are theoretically 
available on CD from theLIST). IMPORTANT: Make sure that your images do not include any borders around the 
map itself if you want to maps to be automatically joined to each other, or if you plan to use Bit Map's navigation 
and location features. 

Multiple contiguous map images (eg, tiles to be merged into a larger single map) can be installed simultaneously if 
all the images are contained in a single zip file with a '.zip' filename extension. Zipping is still recommended even 
for single individual images, as it can dramatically reduce the installation time. 

If you wish to use Bit Map's location and navigation features, or if you wish to combine several map files into a 
single large map on your iPhone, then a little more preparation of the files is required. In particular, each file needs 
to be named in a strict format that describes the precise region of the Earth represented by the map (the required 
information should be printed on the map before you scanned it, embedded in the file, or otherwise available from 



the map supplier). Note that the location and navigation features are currently only supported for UTM or
 
latitude/longitude maps (which are the most commonly used maps for most purposes).
 

Each file name should be of the format:
 

projection datum zone left bottom right top.ext
 

Where:
 

•	 projection = One ofthe compatible projection abbreviations (see below). Optional - if not provided, 
UTM will be assumed. 

•	 datum = One of the compatible map datum abbreviations. See below for a complete list of datums that Bit 
Map can use. Optional - ifnot provided, WGS84 will be assumed. 

•	 zone = The UTM zone for the map (NB: maps that cover multiple zones, or which use coordinates from 
other zones, are not currently supported for navigation features). UTM maps only - do not include a zone 
for non-UTM maps. 

•	 left = The 'easting' coordinate (in metres or longitude) for the left edge of the map. 
•	 bottom = The 'northing' coordinate (in metres or latitude) for the bottom edge of the map. 
•	 right = The 'easting' coordinate (in metres or longitude) for the right edge of the map. 
•	 top = The 'northing' coordinate (in metres or latitude) for the top edge of the map. 
• ext = A supported image file extension. 

Notes for Specifying the Left, Bottom, Right, Top Values 

The values for the left, bottom, right and top must be specified as numbers (with or without a decimal point) with no 
other characters (eg, do not include 'N', 'S', '0').
 

For UTM maps, this MUST be the UTM grid references (in metres).
 

For latitude/longitude maps, this must be the latitude and longitude coordinates in simple decimal degress (NOT
 
with minutes or seconds). NB: longitude before latitude (ie, left before bottom, and right before top). Use
 
negative numbers for west or south.
 

Once your files are named correctly, they can be installed into Bit Map. If you wish to have several maps joined
 
together, you should zip them into the one single zip file before installing into Bit Map.
 

A LatitudelLongitude Example 

For example, a map of the world could be named: 

latlon WGS84 -180 -90180 90.jpg 

assuming it is drawn in a straight latitude/longitude grid, uses the 'WGS84' map datum, and covers the area between 
latitude/longitude coordinates -90°, -180° (bottom, left) and 90°, 180° (top, right). Note that in the filename, the 
longitude comes before the latitude for both points. Because the map is using the default datum, WGS84, that 
element is optional, and this file could be simply named: 

latlon -180 -90180 90.jpg 



A UTM Example 

For example, the new version of the Tasmap 1:25,000 UTM map '5041' (Launceston) saved as a JPEG would be 
named: 

UTM GDA94 55G 5000005410000520000 5420000.jpg 

because it is drawn in the UTM projection, uses the 'GDA94' map datum, is entirely within the UTM zone '55G', and 
covers the area between easting/northing coordinates 500000, 5410000 (left, bottom) and 520000, 5420000 (right, 
top). Note that UTM is Bit Map's default projection and GDA94 is virtually identical to the default datum, WGS84, 
therefore these two elements are optional, and this file could be simply named: 

55G 500000 5410000520000 5420000.jpg 

Conversion Between Coordinates and Grid Reference Notations 

There are several online tools available for converting between the various notations for specifying coordinates or 
grid references. Either from latitude/longitude to UTM or visa-versa, or between degrees-minutes-seconds, and 
simple decimal degrees. Use your preferred internet search engine to find some of these tools. One example of such 
a tool is: 

http://www.rcn.montana.edu/resources/tools/coordinates.aspx 

Note that if using latitude and longitude, Bit Map requires decimal notation, not minutes-seconds notation. 

.map Calibration Method 

NB: This method is experimental and .map file calibration is not fully supported yet. However, this method is 
much simpler than manual preparation, so may useful for people who already have valid OziExplorer ".map" files 
associated with their map images. 

Before you begin, each image file must have an associated ".map" file which describes the map in that image. One 
important caveat is that Bit Map's .map file support is currently only partial and it only works with .map files which 
have MMPXY and MMPLL lines that define the furthest points in all four directions (top, bottom, left right) of the 
image, excluding any border around the map part of the image, and it only works for UTM or lat/lon projections. 

Place the map image file(s) and the associated .map metadata file(s) in a directory (folder) and then compress that 
folder to a .zip file. This .zip file can then be loaded into Bit Map. If you wish to have several maps joined together, 
you should place them all in the same directory and then zip them into the one single zip file before installing into 
Bit Map. 

Some important notes for the .map method: 

•	 Supports UTM and latitude/longitude maps only (the most commonly used maps). 
•	 Rounds the definition ofUTM map edges to the number of metres configured in settings. Often, a setting 

of 100 or 1000 improves accuracy ofthe latitude/longitude values supplied for the edges in most .map files, 
where the .map calibration is not entirely accurate and the map boundaries are known to be on 100 or 1000 
metre intervals. 



•	 Automatically trims margins from map images according to the specifications in the .map files, if they have 
not already been trimmed by exporting from OziExplorer. OziExplorer will trim during export, but other 
file conversion applications do not - Bit Map should handle both trimmed and untrimmed images correctly. 

Naming Maps 

If you moved the map file(s) into a folder (directory) before zipping them, then Bit Map will use the name of this 
folder as the display name for the map. If you did not place the maps file(s) into a folder before zipping them, then 
Bit Map will use the name of the zip file itself as the display name for the map. 

This allows you to have a good human readable name for the map (from the name of the folder), but a different 
short, easy to type name for downloading from Bit Map (from the name of the zip file). Eg, for a map of Tasmania 
at a scale of I :250,000 you could name the folder "Tasmania 250,000" for easy reading in Bit Map, and after zipping 
it, rename the zip file "tas250.zip" for easy typing when uploading/downloading into Bit Map. 

Installation (for Map Files and for KML/KMZ Files) 

Maps (converted and calibrated as detailed above) and KML files can both be loaded into Bit Map on an iOS device 
(iPhone or iPad) using much the same process. There are four different ways for Bit Map to load maps and KML 
files. Choose whichever of these methods suits your circumstances the best: 

I.	 Using iTunes' file sharing over USB. This is by far the fastest (by several orders of magnitude) and easiest 
method if you are able to physically connect the device to a computer running iTunes which also has your 
map or KMLIKMZ files on it. 

2.	 Emailing files as email attachments to an account which can be read on the device. This is the easiest 
method. It is not as quick as the iTunes method above, but doesn't require physical connection of the 
device to another computer. 

3.	 Uploading files via WiFi from your desktop/laptop to Bit Map, directing the web browser on your 
Desktop/Laptop to the URL that Bit Map displays in its acquisition view. While in the acquisition view, 
Bit Map will run its own built-in web server ready to receive files from web browsers on the local network 
(NB: The desktop/laptop uploading the files must be on the same local network as the iPhone running Bit 
Map, and Bit Map must be displaying it's acquisition view for this to work). 

4.	 Downloading files from a web server somewhere on the internet (or on your local network) using URLs 
that you enter into Bit Map itself. This means that you first need to upload your prepared map image files to 
a web server. Any computer can act as a web server, so long as it is configured correctly. If you don't 
already have upload access to a web server, you may be able to set up your desktop/laptop as a temporary 
web server. 

These methods are all explained in more detail below. Before you can install your maps in Bit Map, you must 
convert and calibrate the maps so that Bit Map can read them and recognise the geographical area represented by 
each map image (see above). 

Install Using iTunes File Sharing Over USB 

9.	 Connect the iOS device (iPhone or iPad) with Bit Map installed to a desktop or laptop computer with 
iTunes running on it. 

10.	 In iTunes, select the iOS device when it appears in the panel at the left side of iTunes' window. 



I I.	 Select the "Apps" tab. 
12.	 Scroll down to the bottom of the Apps tab to the file sharing section, and select "Bit Map" in the list of file-

sharing compatible Apps. 
13.	 Drag your map files (usually in a .zip file) or KML/KMZ files into the pane to the right. 
14.	 Wait for iTunes to finish copying the file(s) to the device. 
15.	 Run Bit Map on the iOS device, then tap the "•••" button on the top toolbar (if in the map view) to see the 

main tab bar, then tap the "+" (acquire) button on the main tab bar. 
16.	 Wait for Bit Map to process the files. 

Email as Attachment 

•	 From any computer, attach the zip file (or KML, KMZ or Image file) to an email message and send the 
message to an email account which can be read on the iOS device which has Bit Map installed on it. 

•	 On the iOS device with Bit Map installed, download and view the email message with the file attached 
(wait for the attachment to completely finish downloading). 

•	 Tap on the attachment and choose 'Bit Map', or 'Open With.. .' and then 'Bit Map' from the selection(s) that 
appear. 

Upload to Bit Map using DesktoplLaptop Web Browser 

OR 

Download to Bit Map from a Web Server 

Both of these two methods are much slower than the iTunes file sharing method, but do not require that the device 
be connected to a computer running iTunes by USB. Both of these two methods use the same first few steps: 

•	 Run Bit Map on the iOS device, then tap the "..." button on the top toolbar (if in the map view) to see the 
main tab bar, then tap the "+" (acquire) button on the main tab bar. 

•	 The acquisition view will be displayed. If the acquisition view is not displayed, and a "Processing 
Acquired Files" alert is displayed instead, then there must have been an incomplete acquisition, and you 
can try again after the processing completes. 



•	 Choose one of the two installation methods below for the remaining instructions. 

Upload to Bit Map using Desktop/Laptop Web Browser 

This method requires that your desktop or laptop computer be on the same local network (subnet) as your iPhone 
(which is usually the case for most people where their desktop/laptop and iPhone are in the same room or building). 

•	 On your desktop/laptop, open a web browser and enter the URL displayed on Bit Map's acquisition view 
(don't forget to include the port number in the URL, usually ":8888"). Bit Maps acquisision web page 
should appear with a form requesting the security code. 

•	 In the desktop web browser, enter the 4 digit security code displayed on Bit Map's acqusition view, and 
click the submit button. The web page should change to a form requesting the file to be uploaded. 

•	 In the desktop web browser, select the file to be sent to Bit Map, and click the "Upload" button (usually an 
image or zip file for maps, and a KML or zip file for routes). The web browser will indicate when file 
upload is complete. 

Download to Bit Map from a Web Server 



This method requires that your files have already been uploaded to a web server that is publicly accessible on the 
internet or on your local network. 

•	 Enter the URL of the file to acquire in the field at the top of Bit Map's acquisition view (or enter the URL 
of a web page with a link to the file to be downloaded, then navigate the link(s) to the file). 

•	 Tap the 'Go' button on the keyboard (or the 'download' button next to the URL field) to begin downloading. 

Acquisition Progress and Optimisation 

Whichever of the methods above are used, Bit Map displays progress indicators to keep you informed of acquisition 
progress, and once the file has been fully received, Bit Map will display an alert indicating that the acquired files are 
being processes. Note that for large files, both of these processes can take a very long time. iPhone sleep is disabled 
during this period, and re-enabled when the process is complete. 

NB: Acquiring large files can take a long time, and uses a lot of processing power. While in progress, Bit 
Map will prevent the iPhone from sleeping to reduce the likelihood of interruption to this processing. This 
processing can use a lot of battery power, so it is advisable to make sure that the iPhone is plugged into a 
power source or at least has a fully charged battery, before beginning acquisition of a large file. 

An alert will inform you when acquisition is complete. 

NB: If you install a map which has the same name as an existing map, it will be merged with the existing map (eg, 
to extend the coverage of the map, or to join two maps which were not both included in the same zip file). 
Otherwise, the new map will be added to the list of maps available in Bit Map. 

Compatible Map Projections 

Bit Map will display maps of any projection, however the location and navigation features will only work for the 
map projections listed below. When specifying the projection in an image filename for Bit Map, you must use the 
abbreviation specified here. Support for other projections my be included in future updates. 

Abbreviation Projection 

UTM Universal Transverse Mercator 

latlon Latitude I Longitude 

Recognised Map Datums 

Map datums are mathematical definitions of the shape of the earth (the 'ellipsoid') combined with a relative offset of 
the ellipsoid's origin from a known point. The following abbreviations represent the internationally recognised map 
datums that are compatible with Bit Map's navigation and location features, and should be used as the datum 
component of file names before installing the files in Bit Map: 

•	 wgs84 



• wgs72 

• nad27 

• nad83 

• a-can 

• eur 

• tokyo 

• aus
 

• osgb36
 

• sam69 

• sad-69 

• pulkovo 

• eur50 

• eur50m 

• eur79m 

• agd66 

• agd84 

• gda94 

• grs80 

• rome40 

• sasia 

• s-42 

• potsdam 

• carthage 

• pulkovo
 

• oid
 

Compatible Image File Formats 

JPEG is the preferred file format to minimise download times, as it has the best compression, however it's 
compression does cause a reduction in image quality. Note that Bit Map converts all files it receives to JPEG, no 
matter what format they were originally in, and uses high compression (by default) in order to minimise the amount 
of storage space used up on the iPhone. 

Bit Map can use original images zipped in any of the following file types: 

• Joint Photographic Experts Group (JPEG) .jpg, .jpeg 
• Portable Network Graphic (PNG) .png 
• Tagged Image File Format (TIFF) .tiff, .tif 
• Graphic Interchange Format (GIF) .gif 
• OziExplorer 2 (OZF2) .ozt2 (non-RC4 only) 
• Portable Document Format (PDF) .pdf(single pages only) 
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1 Getting Started 

1.1 Setting Up Your iTunes Computuer 
The iPad, much like an iPod, uses the iTunes application to initialize, and load apps and data (refered to as 
"syncing" the iPad). Multiple iPads can be synced with a single computer running iTunes, but iPads cannot easily 
be synced with more than one iTunes computer (attempting to sync an iPad to a second computer will erase all the 
existing data on the iPad). This means that your iPads will be tethered to a single computer running iTunes, which is 
effectively your base station. Multiple det sites should have their own iTunes computer. 
At a minimum, this computer must have a recent version ofiTunes installed. To be fully effective (capable of 
adding new maps and GRGs to the iPad), you also need to instal1 an application called "OziExplorer". Also, it's 
recommended that you have Falconview with any map data that you will potentially want to add to your iPad, 
Adobe Professional, and a photo editor ("Microsoft Office Picture Manager," which comes with Microsoft Office, 
should be adequate) installed. 

2 iTunes 
iTunes is the program that you will use to initialize new iPads, load applications, backup and update the iPads. 

2.1 iTunes Settings 
From iTunes, go to Preferences under the Edit menu, and select the Devices tab. Check the "Prevent iPods, iPhones, 
and iPads from syncing automatically" checkbox. This will prevent your iPads from backing themselves up and 
syncing automatically when connected to the computer. 
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Next, note the list of Device Backups. iPads will attempt to create a backup whenever they are synced. In our 
implementation, the backup is the best way to maintain standardization and replicate a common iPad image. For 
this reason, you will want to control when backups are created, and delete unnecessary backups. 

2.2 Downloading iPad Apps 
Before you load apps to an iPad, they must be downloaded to your iTunes computer. This requires unrestricted 
access to the iTunes store via the internet. In theater, this probably requires a special arrangement with your S­
6/G-6 or the local WiFi contractor. Only two things require access to the internet: downloading apps, and 
initializing a new iPad (see below). Obviously doing both at the same time will minimize the number of times you 
need to connect the iTunes computer to the internet. 

STORE 

To download apps, open iTunes and select "iTunes Store" from the left menu. C lTunes Store Using the search 
menu, fmd the following apps: 

• BitMap ($2.99, required) 

• GoodReader ($0.99, recommended) 

• Adobe Ideas (Free, recommended) 



To purchase these apps, you will need to create an iTunes account, and supply credit card infonnation. Obviously 
whose credit card you use is up to you, but it's important to consider the fol1owing: the apps you purchase will 
belong to the owner of that iTunes account. A single iTunes account can be associated with up to 5 iTunes 
computers. Once apps have been purchased on an account, they can be downloaded for free to another computer, 
provided that iTunes computer has been associated with the same account. To do this, select "Authorize this 
Computer" from the "Store" menu in iTunes. You wil1 need the useniame and password associated with the 
account, and you will need to be connected to the internet. If you use personal accounts, as personnel swap out, you 
may need to repurchase the apps under another user's name. If you replicate an iTunes computer by "ghosting" the 
hard drive - you will still need to authorize the new computer, or download the apps again using a different account. 
Once the apps have been downloaded to your iTunes computer you win be able to install them on any iPads that you 
sync to this computer, following initialization of the iPad. 

2.3 Initializing a New iPad 
iPads will not tum on until they are first connected to a computer which is running iTunes and can connect to the 
iTunes store via the internet. With a new iPad, connect it to a 
computer running iTunes, and follow the prompts to initialize. 
Note that you do not want to register the iPad on the internet ­
cancel this step. If your copy ofiTunes has already been used to 
setup an iPad, on subsequent iPad initializations, iTunes should 
ask you whether you want to use the existing image or treat this 
iPad as a unique device (the verbage is a bit different, but that's 
the idea). Tel1 iTunes that you want to treat each iPad the same. 
Next, under the "Apps" tab for the device, ensure all the 
checkboxes are checked to sync the various apps. 
At this point, select the Sync button to copy the apps to the iPad. 
Next, if you've already backed up a good iPad image, you can 
replicate that image onto your new iPad by fol1owing the steps 
below under "Restoring / Updating an iPad". If this is your first 
iPad, then you will need to fol1ow the steps for uploading data to 
BitMap using the WiFi. When you've got your first iPad set up as 
desired, follow the steps under "Creating a Backup and Version 
Control" to make a backup, then replicate your remaining iPads 
from that backup image. 

2.4 Restoring / Updating an iPad 
The backup feature of iTunes is an effective way to backup a good 
iPad image, and use that image to restore malfunctioning iPads, or 
propagate changes to other iPads. This is simpler than making a 
series of changes to each of your iPads separately. 
Of note, the restore from backup does not copy new apps to an 
iPad. If you have apps in iTunes that need to be added to a 
particular iPad, first sync the iPad to install the apps. However, 
when the sync process begins, the first step will be to back up. 
You'll see the display below: 
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see the following message, which is fine: 
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This just informs you that you canceled the backup.
 
When the Sync is complete, right click on the iPad (under "Devices") on the left pane, and select "Restore from
 
Backup...". Select the backup (listed by date - there should only be one if you delete old images).
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The restore process will take 5-10 minutes. After it is complete, this iPad should be identical to the iPad from which 
the backup was made. 

2.5 Creating a Backup and Version Control 
The backup feature allows you to create a master "image" that can be used to easily update or restore your 
individual iPads. To create a backup, first make whatever changes (uploading new GRGs, changing iPad settings, 
etc.) are required to a single iPad. 
Next, it's beneficial to have a version displayed on the iPad to help with version control. The technique we use is as 
follows. The powerpoint file ''iPad Background with Version.pptx" is a single slide, with a wallpaper image for the 
iPad and a text box indicating the date of the most recent version. Change the date in the text box, and then select 
"Save As ... " from the file menu. Select JPEG from the file types drop down and hit Save. Next, make this image 
the wallpaper for the iPad. There's more than one way to do this, but one technique is to copy the file to the "My 
Pictures" folder under "My Documents" and use the sync photos feature of iTunes to move the photo to your iPad. 
From the Photos app you can set the wallpaper. If you want to subsequently delete the photo from the Photos app, 
you'll have to delete it from "My Pictures" and resync. (Once the photo is set as the wallpaper, it doesn't also need 
to be in the Photos app.) 
Once you've finished your improved iPad setup, to include indicating the version, return to iTunes, right click on the 
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iPad on the left pane, and select "Back Up". 
The backup process may take 10-15 minutes. This will allow you to use the 
same image to replicate this iPad's contents exactly, which is simpler and less 
error-prone than making detailed changes to each of your iPads separately. 
You may want to record the date and time of the backup image, in case another 
user creates a backup, or you sync another iPad and forget to cancel the backup 
process. With multiple backups saved in iTunes, the only way to differentiate 
them is the date and time the backup was performed. 

3 BitMap 
Bit Map is an iPad app which is designed to use GPS to indicate your position and route on a map. What makes it 
unique is the ability to import your own map layers from georectified picture files (JPEGs). The majority of other 
GPS apps on the iPad (Google Maps, Google Earth, MotionX HD, etc.) provide only a limited built-in set of world 
maps and/or require you to be constantly connected to a WiFi or 3G network to download coverage of your area. 



Bit Map does not have all the features one would desire in a GPS app, but it does give us a moving map capability,
 
together with a seamless GRG layer (no GRG boundaries!), and a limited search functionality.
 
The "Bit Map User Guide" and "Bit Map Files Acquisition Guide" tell you most of what you need to know about
 
using and administrating Bit Map. Below I'll cover some items unique to our particular implementation. If you've
 
been provided with zip files with maps ready-made for BitMap, follow the instructions under "Uploading Maps to
 
Bit Map" to move these maps to your iPad.
 

3.1 Producing Maps for Bit Map 
Begin by assembling JPEG images of your desired map layer. In the case ofGRGs, this means downloading the 
JPEG format from MCIA, or using Adobe Pro to save GRG PDF files as JPEGs. An important consideration is that 
each individual map image should be no more than 6MB. The save options in Adobe can be adjusted to create 
smaller (lower-res) JPEG files. Another technique is to use photo editing software like Microsoft Office Photo 
Manager to change the file size of the JPEGs. The tradeoff is always file size vs. resolution. 
In order to create a large map, create adjoining (overlap is ok) images below 6MB each. If you are producing a map 
layer other than GRG coverage (e.g., 1: lOOk), a good technique is to use the area chart tool in Falconview to 
produce adjoining pages of an appropriate size. Select Adobe as your printer to create a PDF, and adjust the page 
size to create the largest tiles possible, without exceeding 6MB per tile. From Adobe Pro, save the PDF as a JPEG. 
Adobe Pro will automatically produce one JPEG for each page. Note the size of the resultant files - you can adjust 
the page size in Falconview to create larger or smaller tiles as necessary. 
Next, use OziExplorer (see below) to georectify the files. Another (optional) step is to use the instructions below 
("Add Labels to a GRG in OziExplorer") to modify the images adding gridline labels. The result of will be a folder 
containing JPEGs and .map files with the same filenames. 
Next, you need to compress (zip) the JPEGs and .map files together. You can either compress a folder containing 
your files (the folder name will be the name of the map layer in Bit Map), or compress the files themselves (the 
name of the zip file will be the name of the map layer in Bit Map). You cannot, however, have multiple folders or 
subfolders in the compressed file. To create the zip file, select your folder (or the files themselves), right click, and 
select "Send To" -> "Compressed (zipped) Folder". Compressing the files may take some time. (Creating the 
"South AO.zip" file, which is 450MB and contains 267 GRGs, can take 4 hours.) 
A key point is that the zip file you provide to Bit Map will constitute a single map (tiles in the zip are stitched 
together). These files should all be of the same scale (don't mix 1:50 and GRGs in a single zip file). Additionally, 
you cannot easily scrollleftJright/up/down between different maps in Bit Map. So if you create Marjah.zip and 
TrekNawa.zip files, will not be able to slide between the two. At the moment, we have "North AO.zip" and "South 
AO.zip" files, but as our georectified GRG coverage becomes gapless, the best solution is most likely to create a 
single zip file for all GRGs. If this file proves unwieldy due to size, look at creating multiple .zip files with 
overlapping zones of coverage (e.g., South AO.zip and North AO.zip which both include the Gereshk area), and be 
alert to the version control issues created thereby. 

3.2 Uploading Maps to Bit Map 
This is well detailed in the "Bit Map Files Acquisition Guide" provided by the author of the app, but I'll reproduce 
the instructions here. Of note, you'll need a WiFi network to transfer files from your iTunes computer to Bit Map 
on your iPad. 

I.	 Ensure both your iTunes computer and your iPad are connected to the same WiFi network. 
2.	 Open Bit Map on your iPad. 

3.	 Tap the l1li option on the top right comer to access the menu screens.

4.	 Tap the "Manage Maps" icon on the bottom menu. •5.	 Tap the D icon on the top right. 
6.	 If your iPad is on the WiFi network, a black screen will appear. This screen provides you with a URL 

(e.g. ''http://192.168.1.1 :8888") and a 4-digit security code. 
7.	 Use Internet Explorer to access the uri (include the ":8888" portion). Enter the security code and click 

"Validate". 
8.	 On the next page, click "Browse" to select the .zip file, then select "Upload". 



9.	 Once the file is uploaded, you'll be able to follow the progress on your iPad. It may take some time 
for BitMap to optimize the received file. Don't tum your iPad off while this is taking place. 

10.	 If the file acquisition fails, a likely culprit is that your compressed file did not contain the correct .map 
and JPEG files. There must be exactly one .map file for each .jpg file, all with the same file names. 
Any extra files will cause an error. 

To upload routes to Bit Map (KML files used to create a searchable sector and/or MGRS grid database), follow the 

exact same steps, except in step 4, select the routes icon. from the bottom. Your .kml files don't need to be 
zipped - you can simply upload individual .kml files. 

3.3 Waypoints in Bit Map 
Bit Map allows you to upload .KML files containing waypoints or routes. Really, Bit Map does not appear to 
distinguish between the two. Waypoints in Bit Map can be searched for by name. We have used this feature in two 
ways. First, we uploaded KML files with every sector in the AO, allowing you to quickly center the display on a 
given sector. Second, we created KML files with every 4-digit grid in the AO (roughly speaking: 100,000m zones 
PP, PQ, PR, PS, NP, NQ are represented) to allow you to center on a 4-digit grid. Note that KML files are uploaded 
in a very similar manner to maps (zipping not required, however). Below I'll explain quickly how these files are set 
up. 

3.3.1 Sector KML 
The sector KML should not require frequent updating, but as MCIA adds or changes sector definitions, you may 
need to adjust the KML file. Unfortunately it is not simple, but the basic concepts are listed here. First, the best 
source for sector definitions is the shape file provided by MCIA. Currently MCIA provides a 
"MCIA_AF_Sector... " shape file and an MCIA_AF_SubSector" shape file. The latter contains the Marjeh sectors 
(technically these are subsectors: sector "V" contains VI through V33, for instance). Outside Marjeh, all sectors are 
3 alphanumeric characters in length. In Marjeh the sectors are I or 2 letters, and the subsector is a I or 2 digit suffix. 
Shp2Kmi is available, and will convert these shape files to KML format. However, this KML file will not import 
directly into Bit Map, because it defines a series ofpolygons vice points. To modify the KML file, I wrote a Visual 
Basic script. Using that script is outside the scope of this document, but it's function is to parse the original KML 
file, take the coordinates which define each sector, average the latitudes and longitudes to generate a (approximate) 
center mass coordinate, and generate a new KML file acceptable for import to Bit Map. KML files are XML 
format, which means incremental changes can be made with a text editor. Note that when working from the shape 
files as described above, you will want to give consideration to removing the Marjeh sectors from the KMLs (A, B, 
C, etc.) and including the Marjeh subsectors instead. Numerous products for producing KML are available, so 
future edits could involve creating an excel table of sectors and latitudes / longitudes, and using an excel to KML 
converter - instead of using Visual Basic. 

3.3.2 Grid KML 
This process is more complex, but shouldn't require modification unless adding another 100,000m zone is desired. 
The KML files for each 100,000m zone define 10,000 waypoints, each of which has the MGRS grid as the name 
(e.g. PQ1234) and the corresponding lat/lon as the coordinate. I used an excel UTM to laUlon converter and a 
Visual Basic script to create the files, but there are other ways to produce a similar KML. A usage note on the Grid 
KML files is that they are extremely large. If, for instance, Bit Map is asked to display the PQ "route", it will 
attempt to display 10,000 points and invariably crash. Also, searching for "PQ 1234" is slower (5-6 seconds) than 
searching for "1234" and selecting "PQI234" from the 6 options listed (1-2 seconds). This is because Bit Map will 
display all matches after the first two characters have been entered in the waypoint search field. There are 10,000 
matches for "PQ", and only 600 or so for any 2-digit number (e.g., "12"). 
Obviously this method of introducing a go-to-grid functionality is a hack, and not an optimal implementation. I 
don't recommend trying to create 6-digit grid KML files, as they will be 100 times larger and unlikely to perform 
well if at all in Bit Map. 



3.3.3 Uploading Waypoints to Bit Map 
The procedures for uploading waypoints are essentially the same as those for uploading maps. See "Uploading 
Maps to Bit Map" above. 

4 OziExplorer 
OziExplorer is an application written by an Australian outdoorsman, which has a variety of features relating to GPS 
and the use of user supplied map imagery. For our purposes, it is useful in that it allows you to easily crop and 
georectify images of maps and GRGs, and the Bit Map app on the iPad is designed to work with the .map files that 
OziExplorer produces. 

4.1 Using OziExplorer to Georectify an Image 
When you georectify (or "calibrate") an image with OziExplorer, the program will produce a file called 
"filename.map" where "filename" is the same name as the image file. The .map file is a small text file with 
instructions regarding the cropping and geographical location of the image. You will want to save the .map file in 
the same folder as the original image. Ultimately you're looking create a .zip file containing a number of map 
images (lPEGs) and corresponding .map files, for upload to Bit Map. Note that your only indication that an image 
has already been georectified is the existence of the .map file - so if you're working with others, look for which 
.map files are missing and start there. Below are step by step instructions to georectify an image. 

21.	 Open OziExplorer 
22.	 Under the File menu, select "Load and Calibrate Map Image" 
23.	 Select your lPEG. This could be a GRG, or any other lPEG of a map (e.g., produced via Falconview 

and Adobe). 
24.	 The image will load with the Calibration menu on the right side. 

25.	 Click the Comer Markers icon to crop the image: [ill 
26.	 Place the comer markers on all four sides to crop the margins off. Use the small zoom window to get the 

placement just right. The GRG borders are generally depicted as dashed lines, and you can see there is a 
very small overlap between GRGs. Try to get as much of the image as possible (including the overlap 
area) without including any whitespace or the black border around the GRG image. 

n.	 Next, ensure the "Map Projection" is Latitude/Longitude. Map projection tells OziExplorer what 
constitutes a straight line across your image - a line oflat/lon or a UTMIMGRS grid line. In the case of 
a GRG, the area is so small it doesn't matter. What does matter is that if you select UTM, BitMap will 
round the borders to the nearest 100m, which will ruin the edge matching. With Latitude/Longitude 
selected, BitMap will not round and your edges will match. 

28.	 Next, you will place 3 points on the image with UTM grid coordinates. Although you can read latllon 
intersections offsome GRGs, do not use these to georectify the image. It is important to use UTM grids, 
based off the MGRS gridlines depicted on the GRG. 

29.	 Select the Point 1 tab. 
30.	 Click on the map at your desired grid line intersection. Use the zoom window to be as accurate as 

possible. 
31. Next, type in the UTM grid. For a brief explanation of UTM, see below: 

Universal Transverse Mercator CUTM) 

MGRS is derived from UTM and they are very similar. The Grid Zone (e.g. 41R) is the same in UTM. However, a 

common convention is to use "N" or "5" for the letter portion, based on whether the zone is in the North or South 

hemisphere. The rest of the UTM grid will eliminate any ambiguity. OziExplorer uses this convention, so our AO is 

41N vice 41R and 415. 



The 100,000m identifier (e.g. PQ in MGRS) is replaced by numbers. A single digit is prefixed to the easting, and a 

two-digit number is prefixed to the northing. For example, the PQ region uses numbers 6 and 34. Thus, 41R PQ 

1234567890 is, in UTM, 41N 612345 3467890. A "10 digit grid" (1 meter accuracy) will always have 6 digits for the 

easting and 7 digits for the northing. OziExplorer is looking for 1 meter grids, so if you pick "4 digit" gridline 

intersections, you'll end up with something like 41N 6120003467000 (that's PQ 12 67). 

In practice the takeaway is that the 100,000m identifier (po, PRJ will determine the numbers to prefix to your 

northing and easting. The MGRSConverter application can convert from MGRS to UTM, and Falconview can also 

be set to display UTM grids in the lower right corner. 

32.	 One you've filled in the grid, be sure to select the next Point tab (Point 2 or Point 3) before clicking on 
the map again. Otherwise you'll change the reference point for the Point you just worked on set yourself 
back a step. 

33.	 Once 3 points have been defined, click "Save". The calibration menu will go away. 
34.	 You have just created a ".map" file that specifies the cropping and coordinates for the image. This file 

will automatically have the same name as the image (which is what you want) and should be saved in the 
same folder as the image. 

35.	 The next step is important to check your work. Select "Grid Line Setup" from the Map menu. 
36.	 Select the "Other Grid" tab. 
37.	 Check "Grid On". The settings should look something like the picture below. Ifnot, adjust them and 

select "Default" to save those settings as the default. 
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38.	 This should display grid lines (blue for the lkm grid lines) across the image, with labels. If these lines 

match up closely with the lines on your map, you've calibrated correctly. Ifyou made an error when 
specifying points in the calibration phase, the lines will not match up, will not display, or will be skewed 
in some fashion. 

39.	 If the grid lines do not look correct, select "Check Calibration of Map" from the File menu. The 
calibration menu will return. Check your work, hit save and overwrite the previously made file. 

40.	 Once the grid lines match, you're ready to repeat the process with another file. 

4.2 Using OziExplorer to Add Grid Line Labels to a GRG 
On many MCIA GRGs (outside Marjah), the grid lines are only labeled on the margins. A result of the 
georectification process is that marginalia will not be displayed, so it is important to add labels to the grid lines for 
display in BitMap. In principle, this just requires you to edit the lPEG image with the desired markup. Below I will 



describe a relatively simple method of doing this using OziExplorer. This process is far less tedious and time 
intensive than using, for instance, Photoshop to add all the desired labels. The process below must be conducted 
after the GRG has been georectified. 

4.2.1 Background - Waypoint Files 
OziExplorer supports loading waypoint files (which are text files) in order to display waypoints at desired locations 
on a georectified image. We use this feature to create grid line labels. The following 100,000m grid zones have 
waypoint files: MP, MQ, MR, MS, NP, NQ, NR, NS, PP, PQ, PR, PS. Each grid zone has four files associated, one 
for each quadrant, e.g. MPNW.wpt, MPNE.wpt, MPSW.wpt, MPSE.wpt. Each file defines 5,000 waypoints. Each 
waypoint displays as a yellow label on a major (lkm) grid line, at a 500m mark between adjacent grid lines. 

4.2.2 Step 1 - Add Labels to a GRG in OziExplorer 
1.	 Open OziExplorer. 
2.	 Under the "File" menu, select Load From File -> Load Map File. 
3.	 Select the .map file for the GRG you want to label. 
4.	 Under the "File" menu, select Load From File -> Load Waypoints From File. 
5.	 Load the appropriate waypoint file (e.g., PRNE.wpt). 

a.Ifyour GRG spans multiple grid zone quadrants, you'll need to load a second file.	 To load 
subsequent waypoint files, select Load From File -> Append Waypoints From File from the 
"File" menu. 

b.	 You shouldn't need more than 2 waypoint files for any GRG. That said, if you did need 3 or 
more, you would run into a constraint. Each file is 5,000 waypoints, and OziExplorer only 
allows you to have 10,000 loaded at any time. Editing the waypoint files in a text editor to 
remove unnecessary points is probably your best solution to this problem. 

6.	 Ifthe small "Map View" window (which displays the whole GRG image on top of the main display) 
isn't open, select Show -> Map View from the "View" menu. 

7.	 Note in the Map View window that your GRG is completely covered with yellow "chickenpox" (the 
yellow grid labels). Ifnot, you may have loaded the wrong waypoint file, or you need to load a second 

one. 
8.	 Next, take a close look to confirm the labels show up at the correct locations (aligned on major grid 

lines, halfway between major grid lines). There is a 50% chance that they aren't at the correct locations. 
Don't ask me why - this doesn't necessarily mean that you didn't georectify the file correctly. If the 
labels are in the wrong location, the next steps will correct the problem. Think of this as giving 
OziExplorer a kick in the junk. 

9.	 Under the "File" menu, select "Check Calibration of Map". This brings up the calibration menu on the 
right. There is probably no need to change your calibration settings. Instead, click "Save" and overwrite 
the existing .map file with a new (identical) .map file. 

10.	 Next, repeat step 5 and reload your waypoint file(s). Note that you could have just skipped step 5 
initially, and assume that OziExplorer needed a kick in the junk, but about half the time these steps 
aren't necessary. 

11.	 Now, your labels should appear in the correct locations. Ifthey still don't, your georectification may 
have been faulty. Repeat the calibration of the map (described above) and ensure your points are 
correct. 

12.	 Once the labels are in the correct location, you can move individual labels if they obscure important 

.tet 
features (like buildings). To do this, click the~- icon on the top menu bar. The icon will "unlock", 
and you can move individual labels around as desired. 

13.	 Next, ensure the grid lines are not displayed. You are about to save the GRG as a new image, and any 
unnecessary overlays will end up on the final product. Under the "Map" menu, select "Grid Line Setup" 



and ensure the "Grid On" checkboxes are unchecked on both tabs. This shouldn't be necessary unless 
you recently turned the grid lines on. 

14.	 Finally, under the "File" menu, select "Save Image to File" and "Color Image". 

15.	 In the save dialog box, you need to type in the name ofthe image. Use the same filename as the lPEG 
(the name of the GRG) but don't include the file extension. It will automatically default to ".bmp" for a 
bitmap file. ("Bitmap" is a type of image file in this context, and bears no relation to the iPad app 
BitMap. In fact, the app BitMap will not accept .bmp images, and we need to convert these to JPEGs.) 

16.	 At some point, view the created bitmap file in any image viewer. Occasionally the bitmap will be 
corrupted in an obvious way - the top or bottom portion of the image will not correspond to the rest of 
the image. This happens about I% of the time, and I believe that it occurs when you are labeling 
multiple images back-to-back with little time in between. If the bitmap is corrupted, just select "Save 
Image to File" again. 

4.2.3 Step 2 - Convert the Bitmap Images to JPEGs 
If you've labeled a number of GRGs, you now have a series of .bmp files, with the same file name as the original 
GRG lPEGs and the .map file. Presumably you save these .bmp files in the same folder as the lPEGs and the .map 
files. There are many ways to convert a .bmp file to a lPEG, and here is a simple one: 

I.	 Select your .bmp files, right click, and 
under "Open With ... " select "Microsoft Office Picture Manager". 

2.	 Microsoft Office Picture Manager will 

open. If you are converting multiple .bmp files, click the til icon to display all the image files in the 
folder. Hold down shift and click to select all the .bmp files that need to be converted. 

3.	 Select "Export" from the "File" menu. 
An Export menu opens on the right. 

4.	 Under "Export with this file format", 
select lPEG. Leave the "Original file names" checkbox checked. Ensure "Export using this size" is set 
to "Original size". Hit "Ok". If you are performing all these steps in the same folder, you are about to 
overwrite the original GRG lPEG files. Be sure that you have a backup somewhere, in case you've 
made a mistake or want to revert to the originals. 

5.	 When the export is complete, you will 
have a new lPEG file, with the same number ofpixels and a slightly larger file size than the original. It 
is important that the number of pixels remain the same - all the GRGs we currently use in BitMap are 
2750 x 4000. The key point to note is that the georectification of the original image was based on pixels. 
So ifyou changed the size ofthe image in pixels at any point during the process of adding labels, the 
image will no longer be georectified properly. This shouldn't be a factor if you've followed the steps 
above. 

You can now follow the steps described above under "Producing and Uploading Maps to BitMap" to import your 
labeled, georectified, GRGs into BitMap. Essentially you need to zip the .map files together with your new labeled 
lPEG files, and upload these to the iPad. 

5 GoodReader 
GoodReader is a general purpose file-viewing application, capable of viewing images, PDFs, and any number of 
other file formats. For our purposes, it is handy in its ability to display HTML files with hyperlinks to other files 
within GoodReader, its handling of large images, and its ability to organize files into a folder structure. Before we 
found Bit Map we used GoodReader exclusively to view GRGs. With Bit Map installed, GoodReader may be 
obsolete for GRG viewing. However, at the moment there are more GRGs in GoodReader than there are 
georectified GRGs in Bit Map. Ultimately it is a good place to store any documents that may be useful in the 
cockpit (NATOPS, lFlRE, etc.), as well as GRGs that you haven't been able to georectify yet. 



5.1 Uploading Files to GoodReader
 
There are 2 ways to move files into GoodReader: via iTunes and using WIFI.
 

5.1.1 Uploading Files using iTunes
 
To some extent this section will apply to any iPad app that support file sync through iTunes. First, connect an iPad
 
to a computer running iTunes. Select the device from the left pane, then select the "Apps" tab. Scroll down to the
 
"File Sharing" portion ofthe page, then select GoodReader to see the display below:
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Click the "Add... " button or drag files into the GoodReader Documents display to send them to GoodReader. File
 
sharing in iTunes is primitive in that you can only send files, not folders, and you can't put files into a specific folder
 
within GoodReader. Even though folders are displayed ("1. Spot Maps", etc.), files you add using this technique
 
will always go into the root directory of GoodReader.
 
A good technique if you need to copy numerous files into GoodReader is to zip them and move the single file over.
 
Next, from your iPad, open GoodReader. You should see the file you just uploaded on the left (in this example,
 
"KJK.zi "). Ta in on the file will ive ou the 0 tion to unzi it.
 

Also, by selecting "Manage Files" on the right, you'll see a number of options to include copying, moving, and 
renaming files or folders. You can use these options to migrate the uncompressed files to their desired destination. 



5.1.2 Uploading Files using WIFI
 
GoodReader allows you to transfer files using a WIFI network. To start, tap this icon on the bottom right menu in
 

GoodReader: :;i~.
 
If WIFI is on in our iPad's settin s, ou'll see a window similar to this:
 

You may connect to your iPad via WiFi now. Visit www.goodreader.net for instructions. 

WiFi status: ON 
Connection: waIting••. 

Use one of the following addresses exactly as you see them: 
1. IP-address: http://169.254.6.106:8080 
2. Bonjour-address: http://3MAW.local:8080 

AnENTION. In order to prevent network connection from breaking, autotocking feature of this 
device is being blocked while you see this window. Your device will NOT automatically turn off and 
battery may get discharged faster. You may consider connecting your device to battery charger or 
USB-port of your computer. 

Note the IP address (''http://169.254.6.106:8080'' in this example). Next, go to "My Network Places" on your 
computer. Select "Add a network place" from the left-hand menu. Click next several times until the dialog below 
appears. (Note that your computer will first try to access the internet, which will waste a few seconds of your time 
if, in fact, the computer is not on the internet.) 
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Type the IP address into the drop-down menu, and click "Next". Click through the remaining steps and an explorer 
window will appear containing the contents of GoodReader. GoodReader's file structure is now basically mounted 
as an external drive, so you can perfonn the nonnal functions of copying, deleting, etc. 

5.2 Using GRGs in GoodReader 
The use of spot maps is covered below, but first we'll look at viewing GRGs themselves in GoodReader. Accessing 
and viewing the files is very straightforward. The iPad tutorials cover other user steps such as copying a to GRG to 
Photos for faster access. A few administrative considerations are in order here. First, GRGs are distributed by 
MCIA on their SIPR website as PDFs and JPEGs. The PDFs are generally 65MB in size. While these are viewable 
in GoodReader, the perfonnance will be very slow. VMFA-232 has solved this by using a different app, called 
"iAnnotate PDF", which they report has very fast perfonnance and allows you to mark-up the GRGs. HMLA-369 



went a different route with GoodReader. We use lPEG versions of the GRGs, which generally load faster. 
However, the lPEGs provided by MCIA are generally 4-5MBs in size. GoodReader takes about 1 second per MB to 
load an image, giving you about 5 seconds to pull up a "full-size" GRG lPEG. Additionally, 5MB GRGs do not 
perform well when ported to Photos, or used in Adobe Ideas (used to draw on the GRG). For these reasons, we've 
compressed the GRGs to I-2MB. The photo management program Picasa (free, produced by Google) was used, and 
the specification for compressing the lPEGs was to limit the long axis to 4000 pixels. Many other photo programs 
can be used to compress GRGs. Ultimately you are trading off resolutions vs. performance. 4000 pixels seems to 
be an acceptable compromise, with load times of about I second and resolution generally equivalent or better to a 
printed map. The high resolution GRGs have also been added to GoodReader - but it is important to inform aircrew 
that the export to Photos feature will not work well with the high resolution GRGs. 

5.3 Creating Spot Maps for GoodReader 
Interactive (hyperlinked) spot maps are a useful way of providing access to the correct GRG. The spot maps that we 
have put in GoodReader are HTML files, containing tables of images, and "image maps" which are a series of 
hyperlinks linking specific regions of the spot map to the appropriate GRGs. A user familiar with HTML will see 
how the spot maps work by viewing the source code in a text editor. A few tips learned from experience are 
provided here. 
GoodReader is a decent HTML viewer, but it struggles in a few cases. First, large images embedded in an html 
page do not perform well. The largest image which performs acceptably appears to be one which is no more than 
1024 pixels on the long axis. Second, HTML pages containing more than 9 images, each 1024 pixels wide, will not 
load properly. This means that your spot maps will need to be constructed out of "tiles" - 9 or fewer images, each 
1024 pixels or less. A convenient way to do this is to use the area chart feature in Falconview to produce map tiles 
of the appropriate size. In the overlay options menu in Falconview, be sure to change the overlap to zero. As 
described above for Bit Map, using Adobe Pro to convert the area chart to lPEGs. Use Picasa to adjust the max size 
to 1024 pixels. Then create an HTML file with a table that puts the pieces back together. 
The next step in creating the spot map is to create image map tags in your HTML file. Without going into 
excruciating detail, two things are worth mentioning. The first is that GoodReader, unlike most HTML 
viewers/servers, is case sensitive. So when constructing links, there is a difference between "MARJAH 9.JPG" and 
"MARJAH 9.jpg". Second, is that creating image maps is manual intensive regardless, but the program "MapEdit" 
will make the process much faster. In MapEdit you can pull up an image, draw rectangles over the desired touch­
sensitive regions (each GRG's coverage area) and specify the name ofthe file (GRG) to link to. The MapEdit 
program will produce the image map HTML code for you. 


